
An	Introduction	to	Finite	Element	

Modelling	with	ONELAB

C.	Geuzaine,	R.	Sabariego,	J.	Gyselinck,	F.	Henrotte,	E.	Kuci

BEST	Summer	Course	– University	of	Liège,	Belgium

August	22-26	2016



2

About	modern	product	development

Design Testing

Development	cycle

How	is	testing	performed? Physical	vs.	Numerical
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Test	of	a	car	– The	physical	crash	test

Costly	(vehicle	250k€,	dummy	50-500k€)	and	time-consuming
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Test	of	a	car	– Numerical	simulations
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Test	of	a	car	– Numerical	simulations
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Test	of	a	car	– Numerical	simulations
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Test	of	a	car	– Numerical	simulations
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Test	of	a	car	– Numerical	simulations

• Nowadays,	typically	more	than	100	numerical	tests	

are	performed	for	1	physical	test

• Both	testing	strategies	are	complementary

Thanks	to	the	finite	element	method	

(and	related	numerical	techniques)
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Finite	element	method	– Domains	of	application

• Finite

Aerodynamics

Plane	engine	flow
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Finite	element	method	– Domains	of	application

• Finite

Structural	analysis

Mechanical	design
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Finite	element	method	– Domains	of	application

Geophysical	modelling

Weather	forecasting
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Finite	element	method	– Domains	of	application

Biomedical	engineering

COMPUMAG–SYDNEY 2011, STATIC FIELDS AND QUASI-STATIC FIELDS (III), PA10.2, CMP–305 2

Fig. 1. Mesh used for the numerical experiments [20]: a) full head (300,000 nodes, 27 tissues), b) grey matter, c) white matter.
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where E[·] is the mathematical expectation. The denominator
can be computed analytically. The integral in the numerator
is computed by means of a Hermite Gauss integration scheme
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the associated
weight in the bi-dimensional Cartesian rule. The deterministic
problem must thus be computed d2 times, with the conductiv-
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Finite	element	method	– Domains	of	application

Electromagnetics

Energy
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Steps	of	a	finite	element	analysis

Geometry

construction

Mesh	

generation

Solution	

computation

Post-

processing

Optimization	

loop
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Steps	of	a	finite	element	analysis

• Many	commercial	software	packages	are	available,	

that	perform	all	the	steps:

• ANSYS,	Abaqus/CATIA/SIMULIA,	Siemens	

NX/Nastran/SAMCEF,	Altair,	ADINA,	COMSOL,	LS-DYNA,		…

• Several	open	source	packages	are	also	available,	but	

most	only	implement	one	step:

• Code_Aster,	deal.II,	CalculiX,	Elmer,	FEniCS,	FreeFem++,	

OpenFOAM,	GetDP,	Gmsh,	Paraview,	...

• This	week:	introduction	to	finite	element	modelling	

with	ONELAB	(http://onelab.info)
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ONELAB

• Open	source,	lightweight	interface	to	finite	element	

software

• The	default	ONELAB	software	bundle	contains

• the	mesh	generator	Gmsh (http://gmsh.info)

• the	finite	element	solver	GetDP (http://getdp.info)

• Many	other	codes	(free	or	not)	can	be	easily	

interfaced	as	well

• Download	the	software	bundle	now	for	Windows,	Linux,	

Mac,	Android	or	iOS	from	http://onelab.info
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Steps	of	a	finite	element	analysis	with	ONELAB

Geometry

construction

Mesh	

generation

Solution	

computation

Post-

processing

Optimization	

loop

ONELAB

Gmsh

GetDP

Python
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This	week	– Objective	of	the	course

As	an	introduction	to	finite	element	modelling,	we	

would	like	you	to

• understand,
• model,

• simulate,	and

• optimize

a	practical	device	with	ONELAB,	and	learn	the	basics	of	

the	finite	element	method	along	the	way

The	device	we	chose	is	a	Micro	Electro-Mechanical	

System	(MEMS):	a	Xylophone	Bar	Magnetometer	(XBM)



19

This	week	– Objective	of	the	course

Xylophone	Bar	Magnetometer	(XBM)	

Micro	Electro-Mechanical	System	(MEMS)

Courtesy

of	IMEC
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This	week	– Objective	of	the	course

• When	an	alternating	current	flows	through	it,	the	

magnetometer	starts	to	vibrate	if	it	is	placed	in	a	

magnetic	field;	the	amplitude	of	the	vibration	can	

be	used	to	measure	the	magnetic	field

• To	increase	sensitivity,	the	frequency	of	the	current	

is	tuned	to	excite	a	resonant	mode	of	the	

xylophone-type	structure

• Modelling	should	take	into	account	the	multi-

physics	coupling	(electromagnetic,	mechanical	and	

thermal)	and	multiple	time	states	(static,	transient,	

harmonic,	eigenmodes)
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This	week	– Schedule

• Monday	10h00-12h00 &	14h00-17h00

• Basics	of	the	finite	element	method

• Tuesday	10h00-12h00	&	14h00-17h30

• Electromagnetics	and	heat	transfer	

• Wednesday	10h00-12h00	&	14h00-17h00

• Mechanics

• Thursday	10h00-12h00	&	14h00-17h30

• Optimization

• Friday	10h00-13h00

• Siemens	LMS	Samtech visit



Geometry	construction
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Geometry	construction	with	Gmsh

• Gmsh uses	a	Boundary	REPresentation (BREP)	

approach	to	describe	geometrical	models:

• volumes	are	bounded	by	surfaces

• surfaces	are	bounded	by	curves

• curves	are	bounded	by	points

• Models	can	be

• built	interactively	using	the	graphical	user	interface	

(which	logs	all	commands	in	a	“.geo”	file)

• scripted	directly	in	“.geo”	files

• imported	from	external	CAD	packages
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Geometry	construction	with	Gmsh

• To	launch	Gmsh,	double-click	on	the								icon
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Geometry	construction	with	Gmsh

• To	open	an	existing	geometry,	use	“File->Open”	and	

select	“models/magnetometer/magnetometer.geo”
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Geometry	construction	with	Gmsh

• Model	parameters	are	on	the	left,	below	the	

“Geometry”,	“Mesh”	and	“Solver”	modules
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Geometry	construction	with	Gmsh

• To	change	a	parameter,	simply	enter	a	value	or	click	

and	slide	the	mouse	across	an	input	field

• In	the	graphic	window:

• The	left	mouse	button	rotates	the	model	and	selects	

objects

• The	middle	mouse	button	(or	the	mouse	wheel,	or	a	

two	finger	zoom	gesture)	zooms	in	or	out

• The	right	mouse	button	pans	(translates)

• For	two- or	single-button	manipulation:

• Middle	click	=	Shift+left click

• Right	click	=	Alt+left click
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Geometry	construction	with	Gmsh

• Common	options	can	be	accessed	by	double-clicking	

in	the	graphic	window
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Geometry	construction	with	Gmsh

• Preset	viewports	and	rotations	can	also	be	accessed	

in	the	status	bar
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Geometry	construction	with	Gmsh

• A	video	tutorial	showing	how	to	create	geometries	

interactively	is	available	here:	

http://youtu.be/nkuawZkiu1w
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Geometry	construction	with	Gmsh

• Let	us	create	a	magnetometer	model	from	scratch:	

select	“File->New”	and	choose	a	name	(“new.geo”)
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Geometry	construction	with	Gmsh

• Select	“Modules->Geometry->Elementary	entities->	

Add->Point”	to	create	a	point
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Geometry	construction	with	Gmsh

• Enter	coordinates	(0,0,0)	and	press	“Add”	(or	choose	

the	position	with	the	mouse	and	press	“e”)
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Geometry	construction	with	Gmsh

• Press	“q”	when	you	are	done;	placing	the	mouse	on	

the	point	will	show	its	attributes
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Geometry	construction	with	Gmsh

If	anything	goes	wrong,	don’t	worry:

• Select	“Modules->Geometry->Remove	last	script	

command”

• This	removes	the	last	command	that	was	added	to	the	

script	“new.geo”	and	reloads	the	updated	script

• Or	select	“Modules->Geometry->Edit	script”

• This	opens	the	script	in	a	text	editor,	where	you	can	

remove	the	erroneous	commands	or	fine-tune	the	

commands	that	were	inserted

• Then	save	the	file,	close	the	text	editor	and	select	

Select	“Modules->Geometry->Reload”
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Geometry	construction	with	Gmsh

• Define	some	variables	by	selecting	“Add->Parameter”:	

w=50e-6,	w2=2e-6,	l=500e-6,	e=2e-6
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Geometry	construction	with	Gmsh

• Create	a	line	of	length	“w”	by	extruding	the	point	

with	“Translate->Extrude	point”;	then	press	“e”
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Geometry	construction	with	Gmsh

• This	is	the	left	side	of	the	magnetometer;	Create	a	

surface	of	width	“w”	with	“Translate->Extrude	line”
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Geometry	construction	with	Gmsh

• Proceed	along	axis	“X”	with	successive	line	

extrusions	of	length	“w2”,	“l”,	“w2”	and	“w”
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Geometry	construction	with	Gmsh

• Create	the	“legs”	by	extruding	by	“w”	and	“-w”	

along	axis	“Y”
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Geometry	construction	with	Gmsh

• Create	the	volume	by	extruding	all	the	surfaces	

(“Ctrl+left click”	to	select	a	region)	along	the	“Z”	axis
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Geometry	construction	with	Gmsh

• Note	that	the	parameters	are	“live”:	you	can	change	

them	in	the	left	menu	and	see	the	result
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Geometry	construction	with	Gmsh

• Select	“Modules->Geometry->Edit	script”	to	see	the	

transcription	of	our	work	so	far
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Geometry	construction	with	Gmsh

• You	can	edit	this	file,	save	it	and	press	“Modules-

>Geometry->Reload	script”	to	reload	it
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Geometry	construction	with	Gmsh

• The	main	commands	we	have	used	are

• Point(1)	=	{0,	0,	0,	1.0};

• This	creates	a	point	with	identification	number	“1”,	at	

Cartesian	coordinates	“(0,0,0)”	and	with	a	target	mesh	

size	of	“1.0”	(the	size	of	the	finite	elements	that	will	be	

created	close	to	this	point)

• w	=	DefineNumber[	50e-6,	Name	"Parameters/w"	];

• This	creates	a	variable	“w”	with	default	value	“50e-6”	
and	ONELAB	name	“Parameters/w”.	ONELAB	names	are	

provided	as	paths,	which	correspond	to	the	tree	

hierarchy	in	the	graphical	user	interface.
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Geometry	construction	with	Gmsh

• Extrude	{0,	w,	0}	{		Point{1};	}

• This	extrudes	the	point	“1”	and	creates	a	line	of	length	
“w”	in	along	the	“Y”	axis

• Extrude {w2,	0,	0}	{		Line{2};	}

• This extrudes the	line	“2”	by	“w2”	along the	“X”	axis

• Extrude {0,	0,	e}	{		Surface{5,	25,	9,	29,	…};}

• This extrudes the	listed surfaces along the	“Z”	axis to	
create	a	volume
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Geometry	construction	with	Gmsh

• The	geometry	is	almost	ready	to	be	meshed	and	used	

for	computing	a	solution:	we	just	need	to	group	

elements	in	“physical	groups”

• We	will	need	one	physical	group	for	each	region	that	

must	be	distinguished	in	the	solution	process:	for	

example,	for	each	material	and	for	each	boundary	

condition

• For	the	magnetometer,	we	define	a	single	“physical	

volume”	(single	material)	grouping	all	the	elementary	

volumes	and	two	“physical	surfaces”	– one	for	each	

electrode,	where	the	structure	is	also	clamped
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Geometry	construction	with	Gmsh

Left	electrodes	(clamped) Right	electrodes	(clamped)
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Geometry	construction	with	Gmsh

• Click	on	“Physical	groups->Add->Volume”,	select	all	

volumes,	choose	a	name	and	press	“e”
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Geometry	construction	with	Gmsh

• Click	on	“Physical	groups->Add->Surface”,	select	the	

electrodes,	choose	names	and	press	“e”
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Geometry	construction	with	Gmsh

• You	can	inspect	all	entities	(elementary	and	

physical)	by	selecting	Tools->Visibility



52

Geometry	construction	with	Gmsh

• To	reset	all	ONELAB	variables	to	their	default	value,	

select	“Reset	database”	in	the	gear	menu
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Geometry	construction	with	Gmsh

• Many	more	commands	exist	in	Gmsh:	examine	in	

more	detail	the	first	tutorials	provided	in	the	

distribution	(in	the	“tutorial”	directory):

• The	complete	documentation	is	available	on	

http://gmsh.info



Mesh	generation
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Mesh	generation	with	Gmsh

• To	generate	a	finite	element	mesh,	select	“Modules-

>Mesh->3D”
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Mesh	generation	with	Gmsh

• The	resulting	mesh	is

• as	coarse	as	possible	(we	set	a	

target	mesh	size	of	“1.0”	on	point	

1,	for	a	structure	of	about	6e-4;	

notice	that	there	are	no	units	at	

this	stage)

• made	of	tetrahedra in	the	

volume,	triangles	on	surfaces	and	

line	segments	on	curves	(select	

“Tools->Statistics”	to	see	the	

details)
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Mesh	generation	with	Gmsh

• Double-click	in	the	graphic	window	and	set	the	

“Global	mesh	size	factor”	to	1e-2
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Mesh	generation	with	Gmsh

• Press	“1D”,	“2D”	and	“3D”	in	“Modules->Mesh”	to	

remesh the	curves,	surfaces	and	volumes
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Mesh	generation	with	Gmsh

• For	a	thin	structure	like	the	

magnetometer,	a	regular	

(“structured”)	mesh	would	

be	more	suitable

• Edit	the	“new.geo”	file	and	

modify	the	Extrude	

commands	by	adding	

“Layers”	options	to	specify	

explicitly	the	number	of	

layers	of	elements	to	be	

generated	in	the	extrusion
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Mesh	generation	with	Gmsh

• Adding	“Recombine;”	will	recombine	all	triangles	

into	quadrangles	and	all	tetrahedra into	hexahedra
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Mesh	generation	with	Gmsh

The	final	“new.geo”	script	after	removing	the	comments:

Point(1) = {0, 0, 0, 1.0};
w = DefineNumber[ 50e-6, Name "Parameters/w" ];
w2 = DefineNumber[ 2e-6, Name "Parameters/w2" ];
l = DefineNumber[ 500e-6, Name "Parameters/l" ];
e = DefineNumber[ 2e-6, Name "Parameters/e" ];
n1 = 5; n2 = 2; n3 = 50;
Extrude {0, w, 0} { Point{1}; Layers{n1};}
Extrude {w, 0, 0} { Line{1}; Layers{n1}; Recombine;}
Extrude {w2, 0, 0} { Line{2}; Layers{n2}; Recombine;}
Extrude {l, 0, 0} { Line{6}; Layers{n3}; Recombine;}
Extrude {w2, 0, 0} { Line{10}; Layers{n2}; Recombine;}
Extrude {w, 0, 0} { Line{14}; Layers{n1}; Recombine;}
Extrude {0, w, 0} { Line{8}; Layers{n1}; Recombine;}
Extrude {0, -w, 0} { Line{7}; Layers{n1}; Recombine;}
Extrude {0, -w, 0} { Line{15}; Layers{n1}; Recombine;}
Extrude {0, w, 0} { Line{16}; Layers{n1}; Recombine;}
Extrude {0, 0, e} { Surface{5, 25, 9, 29, 13, 37, 17, 33, 21}; Layers{n2};

Recombine;}
Physical Volume("Magnetometer") = {2, 1, 3, 4, 5, 6, 7, 9, 8};
Physical Surface("Left Electrode") = {76, 120};
Physical Surface("Right Electrode") = {164, 208};
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Mesh	generation	with	Gmsh

• To	save	the	mesh	to	disk	in	the	default	mesh	format,	

select	“Modules->Mesh->Save”

• The	“File->Save	As”	menu	has	many	more	options	to	

save	the	mesh	in	various	formats	suitable	for	

different	solvers,	or	to	export	images.	Simply	

choosing	a	file	name	with	the	right	extension	(e.g.	

“image.png”	for	a	PNG	image)	will	select	the	

appropriate	file	format

• You	can	mesh	without	the	graphical	user	interface,	

by	opening	a	terminal	and	typing:	“gmsh new.geo -3”



Solution	computation
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GetDP solver

• GetDP is	a	rather	general	finite	element	solver,	

whose	main	feature	is	the	closeness	between	the	

input	data	defining	discrete	problems	(written	in	

plain	text	“.pro”	files)	and	the	symbolic	

mathematical	expressions	of	these	problems

• ONELAB	uses	GetDP both

• as	a	“black-box”	solver,	if	a	template	problem	

definition	is	available

• as	a	fully	customizable	solver,	when	the	physical	

problem	definition	is	written	from	scratch
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GetDP solver	– Using	a	template

• If	a	template	for	the	given	physical	problem	already	

exists,	simply	merge	it	along	with	the	geometrical	

description	with	“File->Merge”

• Simple	templates	are	provided	in	the	“templates”	

directory
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GetDP solver	– Using	a	template

• “File->Merge”	the	“Electrostatics.pro”	template	with	

the	magnetometer	geometry
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GetDP solver	– Using	a	template

• Materials	and	boundary	conditions	can	be	specified	

interactively	on	the	available	physical	groups
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GetDP solver	– Using	a	template

• Once	the	parameters	are	chosen,	press	“Run”	to	

compute	the	solution
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GetDP solver	– Using	a	template

• We	will	see	later	how	to	exploit	the	results	in	the	

post-processing	module
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GetDP solver	– Constructing	your	own	model

• In	order	to	construct	your	own	physical	model,	you	

need	to	start	with	the	mathematical	description	of	

the	physical	problem	as	partial	differential	equations

• The	finite	element	method	allows	to	solve	such	

partial	differential	equations	in	so-called	“weak	

form”,	after	discretization	on	a	mesh

• The	next	slides	provide	a	short	summary	of	the	

general	approach	– you	will	study	details	for	

electromagnetics,	heat	transfer	and	mechanics	on	

Tuesday	and	Wednesday
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GetDP solver	– Constructing	your	own	model

• Let	us	assume	that	the	physical	problem	we	want	to	

solve	is	modelled	by	the	following	partial	differential	

equation	on	the	open	set														,	with	

homogeneous	boundary	conditions	on	the	

boundary							:

• Given																	and									,	we	want	to	find										

everywhere	in	

div↵(x)gradu(x) = f(x), x 2 ⌦

u(x) = 0, x 2 @⌦

⌦ ⇢ R3

@⌦

f(x)↵(x) > 0 u(x)

⌦
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GetDP solver	– Constructing	your	own	model

• For	general					,										and										there	is	no	closed	

form	solution	for	

• The	main	idea	behind	the	finite	element	method	is	

to	look	for	the	solution										such	that	the	partial	

differential	equation	is	satisfied	when	tested	against	

well-chosen	test	functions

• Mathematically,	we	look	for										,	with																	

on				 , such	that

holds	for	all	appropriately	chosen	functions										

f(x)

u(x)

⌦ ↵(x)

u(x)

u(x) u(x) = 0

@⌦
Z

⌦
(div↵(x)gradu(x)) u0(x) d⌦ =

Z

⌦
f(x)u0(x) d⌦

u0(x)
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GetDP solver	– Constructing	your	own	model

• The	differential	operators								and											should	be	

understood	in	the	distributional	sense	(think	

about	 being	discontinuous)

• Integrating	by	parts,	the	problem	becomes:	find

such	that

holds	for	all	

• The	finite	element	methods	consists	in	

approximating										by												in	a	finite	dimensional	

function	space

div grad

↵(x)

u(x)

�
Z

⌦
↵(x)gradu(x) · gradu0(x) d⌦ =

Z

⌦
f(x)u0(x) d⌦

u0(x)

u(x) uh(x)
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GetDP solver	– Constructing	your	own	model

• For	classical	finite	elements,	this	means	taking										

and	the	test	functions	in	

where	the	basis	functions																																		are	

associated	with	the						vertices	of	the	mesh

• Lowest	order	basis	functions	are	linear	on	line,	

triangle	and	tetrahedral	elements,	bilinear	on	

quadrangles	and	trilinear	on	hexahedra;	their	value	

goes	from	1	at	the	associated	vertex,	to	0	on	the	

other	vertices

F 0(⌦) = span{s1(x), s2(x), . . . sN (x)}
si(x), i = 1, . . . , N

N

uh(x)
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GetDP solver	– Constructing	your	own	model

si(x)

iVertex
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GetDP solver	– Constructing	your	own	model

si(x) + sj(x)

i
j

Vertex
Vertex
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GetDP solver	– Constructing	your	own	model

• Injecting																																																in	the	weak	form

and	taking	for											:																																			leads	to	a	

system	of	linear	equations,	for																						:

u(x) ⇡ uh(x) =
NX

i=1

uisi(x)

�
Z

⌦
↵(x)gradu(x) · gradu0(x) d⌦ =

Z

⌦
f(x)u0(x) d⌦

u0(x) si(x), i = 1, . . . , N

�
NX

i=1

ui

Z

⌦
↵(x)grad si(x) · grad sj(x) d⌦ =

Z

⌦
f(x) sj(x) d⌦

j = 1, . . . , N
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GetDP solver	– Constructing	your	own	model

• In	matrix	form,	we	have

with

This	is	the	system	solved	by	the	computer,	e.g.	using	

LU	factorization

• The	matrix						is	very	sparse,	since	basis	functions	

associated	with	distant	nodes	have	disjoint	support	

– leading	to	many	zero	integrals

Au = f

u = [u1, u2, . . . , uN ]T

Aij = �
Z

⌦
↵(x)grad si(x) · grad sj(x) d⌦

f = [

Z

⌦
f(x) s1(x) d⌦, . . . ,

Z

⌦
f(x) sN (x) d⌦]T

A
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GetDP solver	– Constructing	your	own	model

• The	implementation	in	GetDP “.pro”	files	reflects	this	

problem	definition	structure:

• Group{	}	defines	the	domains	(i.e.						and							)

• Function{	}	defines	the	functions	(i.e.											and									)

• FunctionSpace{	}	and	Constraint{	}	define	the	function	

space	(i.e.												)	and	associated	constraints	(

on							)

• Formulation{	}	defines	the	weak	form

⌦ @⌦

f(x)↵(x)

F 0(⌦) u(x) = 0

@⌦
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GetDP solver	– Constructing	your	own	model

• Additional	objects	define

• Integration	methods:	Integration{	}

• Geometrical	transformation	methods:	Jacobian{	}

• Resolution	steps:	Resolution{	}

• Post-processing	specifications:	PostProcessing{	}	and	

PostOperation{	}
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Definition of Discrete Problems

10 objects defined in text data files (“.pro files”)

Group

Function

Constraint

FunctionSpace

Jacobian

Integration

Formulation Resolution

PostOperation

PostProcessing

(Top: particular to a given problem. Bottom: particular to a method of resolution)

4

GetDP solver	– Constructing	your	own	model

Top:	particular	to	a	particular	test-case

Bottom:	generic	for	a	physical/mathematical	model
10	objects
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GetDP solver	– Constructing	your	own	model

1. Group

• Regions	(physical	groups)

• “Functions”	on	regions	(nodes,	edges,	edges	of	tree,	…)

Group: Topological Entities

• Regions

• “Functions” on regions (nodes, edges, edges of tree, dual
faces, ...)

Group{
Air = Region[1]; //simple group (linked with the mesh)

Core = Region[2];

Gamma = Region[{3,4}];

Omega = Region[{Air, Core}]; //combining groups

nodes = NodesOf[Omega]; //function group

edgesOfSpanningTree = EdgesOfTreeIn[Omega, StartinOn Gamma];

}

5
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GetDP solver	– Constructing	your	own	model

2. Function

• Piecewise	definition	(on	groups)

• Space/time	dependent,	with	arguments

• For	physical	characteristics,	sources,	contraints,	…

Function: Functional Expressions

• Piecewise definitions

• Space-time dependent

• Physical characteristics, sources, constraints, ...

Function{
f = 50; //constants

mu0 = 4.e-7 * Pi;

mu[Air] = mu0; //piecewise definition

mu[Core] = mu0 + 1/(100 + 100 * ($1)^6); //argument ($1)

TimeFct[] = Cos[2*Pi*f*$Time] * Exp[-$Time/0.01]; //current value

}

6
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GetDP solver	– Constructing	your	own	model

3. FunctionSpace

• List	of	basis	functions	associated	with	nodes,	edges,	

faces	or	volumes,	of	various	orders

• Local	or	nonlocal	(fluxes,	circulations,	…)

FunctionSpace: Discrete Function Spaces

• Basis functions (associated with nodes, edges, faces, ...) of various orders

• Coupling of fields and potentials

• Definition of global quantities (fluxes, circulations, ...)

• Essential constraints (boundary and gauge conditions, ...)

FunctionSpace{
{ Name H1; Type Form0; //discrete function space for H1_h

BasisFunction {
{ Name wi; NameOfCoef fi; Function BF_Node; //‘‘P1 finite elements’’

Support Omega; Entity NodesOf[All]; }
}
Constraint {

{ NameOfCoef fi; EntityType NodesOf; NameOfConstraint Dirichlet; }
}

}
}

7
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GetDP solver	– Constructing	your	own	model

3. FunctionSpace

//higher-order version

FunctionSpace{
{ Name H1; Type Form0;

BasisFunction {
{ Name wi; NameOfCoef fi; Function BF_Node; //order 1

Support Omega; Entity NodesOf[All]; }
{ Name wi2; NameOfCoef fi2; Function BF_Node_2E; //order 2

Support Omega; Entity EdgesOf[All]; }
}
Constraint {

{ NameOfCoef fi; EntityType NodesOf; NameOfConstraint Dirichlet; }
{ NameOfCoef fi2; EntityType EdgesOf; NameOfConstraint Dirichlet2; }

}
}

}

8



86

GetDP solver	– Constructing	your	own	model

4. Constraint

• Constraints	on	FunctionSpace coefficients	(boundary,	

periodicity,	initial	and	gauge	conditions,	…)

• Topology	of	circuits	with	lumped	elements

Constraint: Constraints on Function Spaces

• Boundary conditions (classical, periodic, etc.)

• Initial conditions

• Topology of circuits with lumped elements

• Other constraints (on local and global quantities)

Constraint{
{ Name Dirichlet; Type Assign; //boundary conditions

Case {
{ Region Surface0; Value 0; }
{ Region Surface1; Value 1; }

}
}

}

12
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GetDP solver	– Constructing	your	own	model

4. Constraint

Constraint{
//time-dependent or harmonic constraints

{ Name Current; Type Assign;

Case {
{ Region CurrentLoop; Value 1000; TimeFunction TimeFct[]; }

}
}

//network relations between global quantities

{ Name ElectricalCircuit; Type Network;

Case Circuit {
{ Region E1; Branch {1,2}; }
{ Region R1; Branch {1,3}; }
{ Region L1; Branch {3,2}; }
{ Region C1; Branch {1,2}; }

}
}

}

2

L1

E1

R1

1
3

C1

13

Constraint{
//time-dependent or harmonic constraints

{ Name Current; Type Assign;

Case {
{ Region CurrentLoop; Value 1000; TimeFunction TimeFct[]; }

}
}

//network relations between global quantities

{ Name ElectricalCircuit; Type Network;

Case Circuit {
{ Region E1; Branch {1,2}; }
{ Region R1; Branch {1,3}; }
{ Region L1; Branch {3,2}; }
{ Region C1; Branch {1,2}; }

}
}

}

13
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GetDP solver	– Constructing	your	own	model

5. Formulation

• Symbolic	equation	builder	(bilinear	and	linear	forms,	

term	by	term)	involving	local	and	nonlocal	quantities

Formulation: Equation builder

• Various formulation types: Galerkin finite elements, collocation,
boundary elements, ...

• Symbolic expression of equations

• Involves local, global and integral quantities based on function spaces

Formulation{
{ Name Maxwell_e; Type FemEquation;

Quantity {
{ Name e; Type Local; NameOfSpace Hcurl_h; }

}
Equation {
Galerkin { [ 1/mu[] * Dof{Curl e} , {Curl e} ];

In Omega; Jacobian Jac1; Integration Int1; }
Galerkin { DtDt [ epsilon[] * Dof{e} , {e} ];

In Omega; Jacobian Jac1; Integration Int1; }
}

}
}

“Find e 2 Hh(curl;⌦) such that
(µ�1curl e, curl e0

) + @2

t (✏e, e
0
) = 0, 8e0 2 Hh(curl;⌦)”

14
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GetDP solver	– Constructing	your	own	model

6. Jacobian

• Mapping	fom reference	to	solution	space

• Geometrical	transformations	(axisymmetry,	infinite	

domains,	…)

Jacobian: Mappings

• Mapping from reference to real space

• Geometrical transformations (axisymmetry, infinite domains, PML, ...)

Jacobian{
{ Name Jac1;

Case { //piecewise defined on groups

{ Region OmegaInf; Jacobian VolSphShell{Rint, Rext}; }
{ Region OmegaAxi; Jacobian VolAxi; }
{ Region All; Jacobian Vol; }

}
}

}

16
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GetDP solver	– Constructing	your	own	model

7. Integration

• Numerical	and	analytic	integration	methods

• Criterion-based	selection

Integration: Integration Methods

• Various numeric and analytic integration methods

• Criterion-based selection

Integration {
{ Name Int1; Criterion Test[];

Case {
{ Type Gauss;

Case {
{ GeoElement Triangle; NumberOfPoints 3; }
{ GeoElement Tetrahedron; NumberOfPoints 3; }

}
}
{ Type Analytic; }

}
}

}

17
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GetDP solver	– Constructing	your	own	model

8. Resolution

• Sequence	of	solving	operations	(system	generation	and	

solution,	time-stepping	and	nonlinear	iterations,	multi-

formulation	coupling,	…)

Resolution: Solver

• Description of a sequence of operations

• Time stepping, nonlinear iterations, ...

• Coupled problems (e.g. magneto-thermal coupling)

• Link various resolution steps (e.g. pre-computation of source fields)

Resolution{
{ Name Parabolic;

System {
{ Name A; NameOfFormulation Parabolic; }

}
Operation{
InitSolution[A];

TimeLoopTheta[tmin,tmax,dt,1]{
Generate[A]; Solve[A]; If[Save[]]{ SaveSolution[A]; }

}
}

}

18
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GetDP solver	– Constructing	your	own	model

9. PostProcessing

• Piecewise	definition	of	quantities	of	interest

• Local	or	integral	evaluation

PostProcessing: Quantities of Interest

• “Front-end” to computational data

• Piecewise definition of any quantity of interest

• Local or integral evaluation

PostProcessing {
{ Name magfields; NameOfFormulation Dynamic;

Quantity {
{ Name b;

Value {
Local { [ -mu[] * {Grad phi} ]; In OmegaCC; }
Local { [ mu[] * h ]; In OmegaC; }

}
}

}
}

19
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GetDP solver	– Constructing	your	own	model

10. PostOperation

• Evaluation	and	export	of	post-processing	quantities	

(maps,	cuts,	…)

PostOperation: Export

• Evaluation of post-processing quantities (e.g. maps, sections, local or
global evaluation, ...)

• Operations on post-processing quantities (sorting, smoothing,
adaptation, ...)

• Various output formats (e.g. space or time oriented, text, binary, ...)

PostOperation {
{ Name Map_b; NameOfPostProcessing magfields;

Operation {
Print[ b, OnElementsOf Omega, File "b.pos", Format Gmsh ];

Print[ b, OnLine {{0,0,0}{1,0,0}} {100}, File "b.txt" ];

}
}

}

20
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GetDP solver	– Constructing	your	own	model

For	our	toy	problem,	the	complete	“new.pro”	file	is:

Group{
Omega = Region[1]; Gamma0 = Region[{2,3}];

}

Function{ 
alpha[Omega] = 1; f[Omega] = -1; 

}

Jacobian { 
{ Name Vol; Case { { Region All; Jacobian Vol; } } }

}

Integration {  
{ Name I1; Case {

{ Type Gauss; Case { { GeoElement Hexahedron; NumberOfPoints 6; } } } }
}

}

Constraint {
{ Name Dirichlet; Case { { Region Gamma0; Value 0; } } } 

}
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FunctionSpace {
{ Name H1_0; Type Form0;
BasisFunction {
{ Name si; NameOfCoef ui; Function BF_Node; 
Support Omega; Entity NodesOf[ All ]; }

}
Constraint {
{ NameOfCoef ui; EntityType NodesOf; NameOfConstraint Dirichlet; }

}
}

}

Formulation {
{ Name Laplace; Type FemEquation;
Quantity {
{ Name u; Type Local; NameOfSpace H1_0; }

}
Equation {
Galerkin { [ - alpha[] * Dof{Grad u} , {Grad u} ];
In Omega; Jacobian Vol; Integration I1; }

Galerkin { [ - f[], {u} ];        
In Omega; Jacobian Vol; Integration I1; }

}
}

}

�
Z

⌦
↵(x)gradu(x) · gradu0(x) d⌦

�
Z

⌦
f(x)u0(x) d⌦

= 0

F 0(⌦) = span{s1(x), s2(x), . . . sN (x)}

u(x) ⇡ uh(x) =
NX

i=1

uisi(x)
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Resolution {
{ Name MyResolution;
System {
{ Name A; NameOfFormulation Laplace; }

}
Operation {
Generate[A]; Solve[A]; SaveSolution[A];

}
}

}

PostProcessing {
{ Name MyPostPro; NameOfFormulation Laplace;
PostQuantity {
{ Name u; Value { Term { [ {u} ]; In Omega; Jacobian Vol; } } }

}
}

}

PostOperation {
{ Name u; NameOfPostProcessing MyPostPro;
Operation {
Print[ u, OnElementsOf Omega, File "u.pos" ];

}
}

}

Au = f
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GetDP solver	– Constructing	your	own	model

• Note	that	Gamma0 in	“new.pro”	does	not	actually	

contain	the	whole	boundary	of	the	magnetometer:	

the	homogeneous	Dirichlet boundary	condition	will	

only	be	applied	on	the	electrodes.	Question:	what	

happens	on	the	rest	of	the	boundary?	(As	an	

exercise,	modify	“new.geo”	to	fix	this.)

• The	complete	GetDP documentation	is	available	on	

http://getdp.info

• We	will	study	the	physics	and	the	implementation	of	

electromagnetic,	thermal	and	mechanical	

formulations	on	Tuesday	and	Wednesday



Post-processing
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Post-processing	with	Gmsh

• Once	you	compute	a	solution	by	pressing	“Run”,	it	is	

merged	and	displayed	automatically	in	the	graphic	

window;	it	is	called	a	“view”

• Check/uncheck	the	views	in	“Modules->Post-

processing”	to	show	or	hide	them

• The	Left/Right	keyboard	arrows	allow	to	navigate	in	

time

• The	Up/Down	arrows	on	the	keyboard	allow	to	

navigate	between	views

• Click	on	the	arrow	next	to	a	view	name	to	access	the	

view	options
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Post-processing	with	Gmsh

• A	video	tutorial	showing	how	to	use	basic	post-

processing	features	is	available	here:	

http://youtu.be/oS3T8i07wkI
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Electromagnetic	models
Different	types	of	field	computations

Electrostatics — Distribution	of	electric	field	due	to	
static	charges	and/or	electric	potential	difference

Electrokinetics — Distribution	of	static	electric	
current	in	conductors

Electrodynamics — Distribution	of	electric	field	and	
electric	current	in	materials	(insulating	&	conducting)

Magnetostatics — Distribution	of	static	magnetic	
field	due	to	static	currents	(DC)	&	permanent	magnets

Magnetodynamics — Distribution	of	magnetic	field	
and	eddy	currents	due	to	time-variable	sources

Full wave — Propagation	of	electromagnetic	fields

C =
Q

V
=

✏S

d

R =
V

I
=

l

�S

� =

r
2

!µ�

L =
�

m.m.f
= n2µ0S

l
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Electrostatics

Phenomena involving  time-independent 
distributions of charges & fields

electric scalar potential formulation in 

no charges
Laplace equation

boundary conditions

in each conducting region
imposed potential at boundary 

conductors

dielectricscurl e = 0

divd = q

d = ✏ e

n⇥ e|�e = 0

n · j|�j = 0

� div (✏ grad v) = q , e = �grad v

+
� div grad v = ��v = 0

⌦c,i, v = vi ) v|�c,i = vi
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Electrostatics

field next to a 220 kV high voltage line

current 
transformer 

isolation

earth

neutral220 V

cable
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Electrokinetics

electric scalar potential formulation

boundary conditions (BCs)

formulation for the conducting region

in each electrode
imposed potential 

curl e = 0

curlh = j ) div j = 0

j = � e

n⇥ e|�e = 0

n · j|�j = 0

�div (� grad v) = 0 , e = �grad v

�e,i, v = vi ) v|�e,i = vi

⌦c
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Electrokinetics

grounding systems:
combination of rods & cables

electric potential distribution
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Electrodynamics

electric scalar potential formulation

curl e = 0

curlh = j + @td ) div (j + @td) = 0

j = � e

d = ✏ e

�div (� grad v + ✏ grad @tv) = 0 , e = �grad v
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Electrodynamics
Tissue Conductivity (S/m)

Muscle 0.2330 
White matter 0.0533
Grey matter 0.0753 – 0.5155
Cerebellum 0.0953 – 0.3020
Eyes 1.5000 
Spinal chord 0.0274
Lungs 0.0684
Heart 0.0827
Veins 0.7000
Liver 0.0367 
Bones 0.0504
Cartilage 0.1714
Nerve 0.0274
CSF 2.0000
Midbrain 0.0643 

ELLA 
Iso2mesh
45 different tissues 
1e6    nodes 
5.8e6 tetrahedra

density of probability

electric field in the white matter (mV/m)

current density in the grey matter (mA/m2)
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Magnetostatics

studied domain

inductor

magnetsimposed current 
density

imposed
voltage

magnetic vector potential formulation
Possible sources:

solenoid

curlh = js
div b = 0

b = µh(+bs)

h = ⌫ b(+hs)

L =
�

m.m.f
= n2µ0S

l

curl ⌫ curla = js , b = curla

js imposed current density in inductor

bs remanent induction if magnets

hs remanent magnetic field if magnets
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Magnetostatics

Switched 
reluctance 
machine

relay

MEMS magnetometer

displacement due to 
the magnetic force

co
il

co
il

co
il

m
ag
ne
t

m
ag
ne
t

mover
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Magnetodynamics	

studied domain

magnetic vector potential formulation

imposed
voltage

imposed current 
density

curlh = j

curl e = �@tb

div b = 0

b = µh+ bs

j = � e+ js

curl ⌫ curla+ � (@ta+ grad v) = js , b = curla

e = �grad v � @ta
reluctivity ⌫ =

1

µ
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Magnetodynamics

eddy current distribution

temperature distribution

Induction heating
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Full	wave

electric or magnetic field formulation

total electric field = scattered field + incident field

+ Silver-Müller radiation condition at infinity 
(outgoing waves)

frequency domain

curlh = j + @td

curl e = �@tb

b = µh

d = ✏ e

j = � e

curl curl e+ �µ @te+ ✏µ @2
t e = 0

curl curlh+ �µ @th+ ✏µ @2
t h = 0

�e� ı!�µ e+ !2✏µ e = 0

�h� ı!�µh+ !2✏µh = 0

time domain ! = 2⇡f

e = es + einc

es = (n⇥ e)⇥ n

curl e⇥ n� ık
�
(n⇥ e)⇥ n

�
=

curl einc ⇥ n� ık
�
(n⇥ einc)⇥ n

�
, on �
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Full	wave

microstrip antenna
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Model	choice

Maxwell’s	equations	&	constitutive	relations	in	frequency	domain,	
without	sources:	

Using	characteristic	lengths
• domain	size
• skin	depth
• wavelength

allows	to	write	them	in	non-dimensional	form:

+	no	RHS	term
Helmholtz equations

�e� ı!�µ e+ !2✏µ e = 0

�h� ı!�µh+ !2✏µh = 0

� = 0

k2 = ⇥2�µ

�e+ k2 e = 0

�h+ k2 h = 0

L

� =

r
2

!�µ

� =

2⇡

k
,wave number k =

!

c
, speed of light c =

1

p
✏µ

⇣ 3

L2
� 2ı

�2
+

4⇡

�2

⌘
e = 0

⇣ 3

L2
� 2ı

�2
+

4⇡

�2

⌘
h = 0
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Model	choice

Maxwell's equations

electrostatics

electrokinetics

electrodynamics

magnetostatics

magnetodynamics

full wave

HF asymptotics

Non-dimensional 
numbers

uncoupled problem
electric/magnetic

⇣ 3

L2
� 2ı

�2
+

4⇡

�2

⌘
e = 0

⇣ 3

L2
� 2ı

�2
+

4⇡

�2

⌘
h = 0

8
>>>>>><

>>>>>>:

g1 =
⇣�

L

⌘2

g2 =
⇣ �

L

⌘2

g3 =
⇣�
�

⌘2
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EM model governing equations

electrostatics

electrokinetics

electrodynamics

magnetostatics

magnetodynamics

full wave

curl e = 0 , divd = q

d = ✏ e

curl e = 0 , div j = 0

j = � e

curl e = 0 , div (j + @td) = 0

j = � e , d = ✏ e

curlh = j , div b = 0

b = µh , h = ⌫ b

curlh = j , curl e = �@tb , div b = 0

b = µh , j = � e

curlh = j + @td , curl e = �@tb , div b = 0

b = µh , j = � e , d = ✏ e



Continuous	mathematical	structure
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Maxwell’s	equations

curlh� @td = j

curl e+ @tb = 0

div b = 0

divd = q

b = B(e,h) = µh (+bs)

d = D(e,h) = ✏e (+ds)

j = J (e,h) = �e (+js)

grad f0 ⌘ rf0 = (@
x

, @
y

, @
z

)f0

curlf1 ⌘ r⇥ f1 ⌘ (@
x

, @
y

, @
z

)⇥ f1

divf2 ⌘ r · f2 ⌘ (@
x

, @
y

, @
z

) · f2
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Square	integrable	vector	fields	
Useful	definitions

The solutions of Maxwell’s equations belong to spaces of square integrable scalar

and vector fields L2
(⌦) and L

2
(⌦). They are defined by

L2
(⌦) =

n

u :

Z

⌦
u2

(x) dx < 1
o

L

2
(⌦) =

n

u :

Z

⌦
ku(x)k2 dx < 1

o

The scalar product of u, v 2 L2
(⌦) and u,v 2 L

2
(⌦) is defined by

(u, v)⌦ =

Z

⌦
u(x) v(x) dx and (u,v)⌦ =

Z

⌦
u(x) · v(x) dx

The norm of u 2 L2
(⌦) and u 2 L

2
(⌦) is defined by

kukL2(⌦) = (u, u)1/2⌦ =

h Z

⌦
u2

(x) dx
i1/2

kukL2(⌦) = (u,u)1/2⌦ =

h Z

⌦
ku(x)k2 dx

i1/2
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Maxwell’s	house	—Tonti	diagram

square integrable 
scalar & vector fields:
field + field with 
differential operator

boundary conditions 
accounted for in
subspaces

boundary split in two 
parts

1-form

0-form

2-form

3-form

2-form

3-form

1-form

0-form

' H1
h(⌦)

oo //

gradh

✏✏

L2(⌦)
OO

dive

h, t Hh(curl;⌦) oo
µ //

curlh
✏✏

He(div;⌦) b
OO

curle

d, j Hh(div;⌦) oo
✏, � //

divh

✏✏

He(curl;⌦) e, a
OO

grade

q L2(⌦) oo // H1
e (⌦) v

H1
f (⌦) = {u 2 L2(⌦) : gradu 2 L2(⌦), u|�f = uf}

Hf (curl;⌦) = {u 2 L2(⌦) : curlu 2 L2(⌦),n⇥ u|�f = n⇥ uf}
Hf (div;⌦) = {u 2 L2(⌦) : divu 2 L2(⌦),n · u|�f = n · uf}

f = e or h
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Classification	of	2nd order	PDEs

EM problems involve linear second order partial differential equations (PDE), for 
the unknown field u and the source function f(x,y), that can be written (2D):

with coefficients a, b, c, d, e, g are functions of x, y, but they can also depend on 
u (nonlinear PDE), homogeneous if f=0, inhomogeneous if f ≠0
From the homogeneous case with constant coefficients, we get

L(u) = a

@

2
u(x, y)

@x

2
+ b

@

2
u(x, y)

@x@y

+ c

@

2
u(x, y)

@y

2
+ d

@u(x, y)

@x

+ e

@u(x, y)

@y

+ gu = f

ax

2 + bxy + cy

2 + dx+ ey + g = 0

8
<

:

b2 � 4ac < 0 elliptic ) steady-state problems

b2 � 4ac = 0 parabolic ) di↵usion problems

b2 � 4ac > 0 hyperbolic ) propagation problems

������

a b/2 d/2
b/2 c e/2
d/2 e/2 g

������
= (ac� b2/4)g + bed/4� cd2/4� ae2/4
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Classification	of	2nd order	PDEs	(cont’d)
elliptic e.g. electrostatics

parabolic e.g. magnetodynamics

hyperbolic e.g. full wave in time domain

e = �grad v, d = ✏e

��v = �@

2
v(x, y, z)

@x

2
� @

2
v(x, y, z)

@y

2
� @

2
v(x, y, z)

@z

2
=

q

✏

n⇥ e|�e = 0

n · d|�d = 0

curl ⌫ curla+ � (@ta+ grad v) = js , b = curla

e = �grad v � @tan⇥ h|�h = 0

n · b|�b = 0
a(t = t0) = a0

curl curl e+ �µ @te+ ✏µ @2
t e = 0

n⇥ (etot � einc) +

r
µ

✏
n⇥ (n⇥ (htot � hinc)) = 0

e(t = tn) = en

e(t = tn�1) = en�1
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Strong	and	weak	formulations
notation

Lu = f in ⌦

Bu = g on �

find u so that

(u,L⇤v)⌦ � (f, v)⌦ +

Z

�
Qg(v) ds = 0 , 8v 2 V (⌦)

X L di↵erential operator of order n

X L⇤
adjoint of L

X B di↵erential operator imposing BC

X f function in ⌦, g function on � = @⌦

X u unknown function

X Qg linear function of v

(u, v)⌦ =

Z

⌦
u · v d⌦

hu, vi� =

Z

�
u · v d�

(Lu, v)⌦ � (u,L⇤v)⌦ =

Z

�
Q(u, v)ds

Q bilinear function of u and v

grad-div type
(v, gradu)⌦ + (divv, u)⌦ = hu, n̂ · vi�

curl-curl type
(v, curlw)⌦ � (curlv,w)⌦ = hv ⇥ n̂,wi�

Continuous system ) 1⇥1
Discrete system ) N ⇥N

) numerical solution
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Strong	and	week	formulations	(cont’d)
e.g. strong electrostatic formulation

governing equations and BCs

��v = �@

2
v(x, y, z)

@x

2
� @

2
v(x, y, z)

@y

2
� @

2
v(x, y, z)

@z

2
=

q

✏

)

8
><

>:

L = ��

f =
q

✏

u = v

n⇥ e|�e = 0

n · d|�d = 0

e = �grad v, d = ✏e

e.g. weak electrostatic formulation

Green formula:
integrating by parts

Z

⌦
��v · w d⌦ =

Z

⌦

⇣
� div (grad v)

⌘
· w d⌦ =

Z

⌦

q

✏
w d⌦

v · gradu+ u divv = div (uv)

Z

⌦

⇣
� div (w grad v) + grad v · gradw

⌘
d⌦ =

Z

⌦

q

✏
w d⌦
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Constraints

• Local	constraints

• boundary	conditions	(BCs)	on	local	fields	at	the	boundary	of	
the	domain

• their	choice	influences	the	final	solution
• they	can	be	exploited	to	reduce	the	computational	domain

• interface	conditions	(ICs):	coupling	of	fields	between	
subdomains

• Global	constraints

• Flux	or	circulations	of	fields	to	be	fixed	(current,	voltage,	e.m.f.,	
m.m.f,	charge)

• Flux	or	circulations	of	fields	to	be	connected	(circuit	coupling)

Lu = f in ⌦

Bu = g on �
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Boundary	conditions	(BCs)

• Dirichlet	BCs:	fix	the	unknown	at	the	boundary	to	a	given	value

• Neumann	BCs:	fix	the	normal	derivative	of	the	unknown	at	the	
boundary	to	a	given	value

• Mixed	BCs:	a	combination	of	Dirichlet	and	Neumann	BCs

Lu = f in ⌦

Bu = g on �

u|� = u0

⇢
= 0 , homogeneous BC

6= 0 , inhomogeneous BC

@u(x)

@n
= w(x), x on �

@u(x)

@n
+ f1(x)u = f2(x) , x on �

f1(x)u and f2(x) explicitly known
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Boundary	conditions	(BCs)	(cont’d)

• Periodic	BCs:	fixing	the	unknown	at	the	boundary	to	a	given	value

• Floating	BCs:	unknown	fixed	to	a	value	that	still	has	to	be	
determined,	often	related	to	global	boundary	conditions

Lu = f in ⌦

Bu = g on �

u(x0) + C1u(x1) = C2 , x0 on �0 , x1 on �1

or

@u(x0)

@n
+ C 0

1
@u(x1)

@n
= C 0

2 , x0 on �0 , x1 on �1
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core

magnet airgap

air
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BCs	— symmetry

symmetry axis symmetry axis

half model!

normal 
component
of induction 
= zero 

core

in
du

ct
or
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Periodic	BCs	

1/8 model
anti-periodic BCs

1/4 model
periodic BCs

p = number of poles
k = 1, 2, 3, . . .

az(r, ✓) = �az(r, ✓ + (2k � 1)
⇡

p
)

az(r, ✓) = az(r, ✓ + 2k
⇡

p
)



Discrete	mathematical	structure
Whitney	elements
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Discrete	mathematical	structure

Replace the continuous spaces (infinite dimension) by
discrete spaces (finite dimension)

W 0(G) ⇢ H1(G)
W 1(G) ⇢ H(curl;G)
W 2(G) ⇢ H(div;G)
W 3(G) ⇢ L2(G)

H1
h(⌦)

oo //

gradh

✏✏

L2(⌦)
OO

dive

Hh(curl;⌦) oo //

curlh
✏✏

He(div;⌦)OO

curle

Hh(div;⌦) oo //

divh

✏✏

He(curl;⌦)OO

grade

L2(⌦) oo // H1
e (⌦)

W 0(G) oo //

grad

✏✏

W 3(G)
OO

div

W 1(G) oo //

curl
✏✏

W 2(G)
OO

curl

W 2(G) oo //

div
✏✏

W 1(G)
OO

grad

W 3(G) oo // W 0(G)

local function spaces on

geometrical element G
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Finite	elements

• set	of	linearly	independent	test	and	trial	functions	(also	called	
basis/shape	functions	and	weighting	functions)

• commonly	piecewise	polynomial

• defined	at	a	structured	grid	or	an	unstructured	mesh

• compact	support

• scalar	or	vectorial	functions
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Finite	elements	geometry	defined	by	nodes

1D

2D

2D

3D

higher order elements1st order elements
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The	Whitney	elements

0-form
nodal BF

1-form
edge BF

2-form
facet BF

3-form
volume BF

Let us consider a mesh of ⌦ formed by geometrical elements G
with nodes N , edges E , faces F , volumes V,

Finite element (G,⌃, S):
X geometrical element G
X ⌃ = set of N Dofs

X S function of finite dimension N

The Whitney elements of order p are expressed as

wn0,··· ,np = p!
pX

j=0

(�1)

m&nmgrad &n0⇥· · ·⇥grad &nm�1⇥grad &nm+1⇥· · ·⇥grad &np

with &n(x) barycentric weight of x with respect to node n in G
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The	Whitney	elements		of	order	0
Nodal	elements

0-form
nodal BF

wn = &n

with n 2 N (node set)

span space W 0
(G)

The interpolation of a function u is given by

I(u) =
X

xi2N
u

i

w

i

with u

i

= ↵

i

(u) = u(x
i

)

X piecewise linear continuous:

first order scalar Lagrange finite elements

X discretisation of scalar fields

X wn = 1 at node n, 0 at other nodes

X wn = 1 is continuous across faces
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The	Whitney	elements	of	order	1
Edge	elements

1-form
edge BF

we = w{m,n} = &m grad &n � &n grad &m,

with e 2 E (edge set)

span space W 1(G)

The interpolation of a function u is given by

I(u) =
X

e2E
uewe

with ue = ↵e(u) =

Z

e
u · dl , 8e 2 E

X Dof = circulations of field along edges of mesh

X discretisation of 1-forms, e.g. h, e

X tangential component continuous across faces

X circulation of we = 1 along edge e, 0 across other edges
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Whitney	elements	of	order	2
Face	elements

2-form
facet BF

wf = w{l,m,n} =

2 (&l grad &m ⇥ grad &n � &m grad &l ⇥ grad &n + &n grad &l ⇥ grad &m)

with f = {l,m, n} 2 F (face set)

span space W 2(G)

The interpolation of a function u is given by

X Dof = flux through faces of mesh

X discretisation of 2-forms, e.g. b, j

X normal component continuous across interfaces

X flux of wf = 1 across face, 0 across other faces of G
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Whitney	elements	of	order	3
Volume	elements

3-form
volume BF

wv = w{k,l,m,n} = 6 (&k grad &l ⇥ grad &m ⇥ grad &n � &l grad &k ⇥ grad &m ⇥ grad &n+

&n grad &k ⇥ grad &l ⇥ grad &m � &n grad &k ⇥ grad &l ⇥ grad &m)

with v = {k, l,m, n} 2 V (volume set)

span space W 3
(G)

The interpolation of a function u is given by

I(u) =
X

v2V
uvwv

with uv = ↵v(u) =

Z

v
u dv

X piecewise constant functions

X Dof = integration over its volume

X discretisation of densities

X P
wv = 1 over the volume of G , 0 over other volumes
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Conformity

Z

@S
h · ⌧̂ dl =

Z

S
(j + @td) · n̂ ds

Z

@S
e · ⌧̂ dl = �

Z

S
@tb · n̂ ds

n̂⇥ (h2 � h1)|S = js

n̂⇥ (e2 � e1)|S = 0
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Conformity

Z

S
d · n̂ ds =

Z

V
⇢ dv

Z

S
b · n̂ ds = 0

Z

S
d · n̂ ds =

Z

V
⇢ dv

Z

S
j · n̂ ds = 0

n̂ · (b2 � b1)|S = 0

n̂ · (d2 � d1)|S = ⇢s



Electrokinetic formulation	and	
discretization
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Electrostatics
Phenomena involving  time-independent  distributions of charges & fields

boundary conditionscurl e = 0

divd = q

d = ✏ e

n⇥ e|�e = 0

n · d|�d = 0
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Electrostatics

volume BF

facet BF

edge BF

nodal BF

edge BF

     
Laplace equation

electric scalar potential 
formulation

no charges
� div (✏ grad v) = q

+
� div grad v = ��v = 0

= curl e

= �grad v

gradh

✏✏

OO

dive

u oo //

curlh
✏✏

0OO

curle

d oo
d = ✏e //

divh

✏✏

eOO

grade

q v

Ampère’s law 
verified in a 
weak sense

curl e = 0, divd = q, d = ✏ e
✏ by  = thermal conductivity

v by ✓ = temperature

q by f = thermal power

Heat conduction problem
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Spatial	discretization	— electrostatics

Weighted residual approach

�div (✏ grad v) = q in ⌦

Z

⌦

⇣
� div (✏ grad v)

⌘
wid⌦ =

Z

⌦
q wi d⌦ , 8wi(x)

wi(x) weighting or test functions
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Spatial	discretization	— electrostatics	(II)
search wiki vector calculus

Weak formulation

integration by parts 
Green formula

divergence theorem

only the first derivative of the electric potential is now required

8wi(x)
Z

⌦

⇣
� div (✏ grad v)

⌘
wi d⌦ =

Z

⌦
q wi d⌦

v · gradu+ u divv = div (uv)

Z

⌦

⇣
� div (wi✏ grad v) + ✏ grad v · gradwi

⌘
d⌦ =

Z

⌦
q wi d⌦

Z

⌦
diva d⌦ =

I

@⌦
a d�

Z

@⌦
wi(�✏ grad v) d�+

Z

⌦
✏ grad v · gradwi d⌦ =

Z

⌦
q wi d⌦
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Spatial	discretization	— electrostatics	(III)

Boundary integral

essential BC natural BC

Z

@⌦
wi(�✏ grad v) d�

8wi(x)

Z

�Dirichlet

wi(�✏ grad v) d�+

Z

�Neumann

wi(�✏ grad v) d�

= 0= 0 8wi(x)
if wi = 0 on �Dirichlet

n⇥ e = et

n · d = dn

n · d = dn
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Spatial	discretization	— electrostatics	(IV)

Ritz-Galerkin method
Petrov-Galerkin method

v =
X

j

ujsj with sj(x) = 0 at �Dirichlet

⇢
sj(x) shape functions

uj unknowns, degrees of freedom

sj(x) = wj(x)

sj(x) 6= wj(x)
Z

⌦
✏ grad v · gradwi d⌦ =

Z

⌦
q wi d⌦

X

j

uj

Z

⌦
✏ gradwj · gradwi d⌦ =

Z

⌦
q wi d⌦

= kij = fi

[kij ][uj ] = [fi]
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Electrokinetics
Phenomena involving  time-independent (static) currents in conductors

boundary conditionscurl e = 0

div j = 0

j = � e

n⇥ e|�e = 0

n · j|�j = 0

curl e = 0

curlh = j ) div j = 0

j = �e

⌦c

n⇥ e|�0e = 0

n · j|�0j = 0

Applied'&'Computa/onal'Electromagne/cs
(ACE)

21

Γ0e,0

Γ0e,1
Γ0j

e=?,'j=?

Ωc

V'='v1'–'v0

Electrokine8cs

Conductor

Boundary'condi/ons

div� grad v = 0 e = �grad v

Example:'electric'scalar'poten/al'formula/on

•'Formula/on'for' the'conduc/ng'region
•'On'each'electrode'''''''''',

with

⌦c

�0e,i v = vi ) v|�0e,i = vi

�1

�2
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Electrokinetics

facet BF

nodal BF

edge BF

= curl e

= �grad v

'

gradh

✏✏

OO

dive

h oo //

curlh
✏✏

0OO

curle

j oo
j = �e //

divh

✏✏

eOO

grade

0 v

Ampère’s law 
verified in a 
weak sense

curl e = 0, div j = 0, j = � e

     
Laplace equation

electric scalar potential 
formulation

� div (� grad v) = 0

+
� div grad v = ��v = 0

Heat conduction problem

� by  = thermal conductivity

v by ✓ = temperature
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Spatial	discretization	— electrokinetics

Weighted residual approach

wi(x) weighting or test functions

�div (� grad v) = 0 in ⌦c

Z

⌦

⇣
� div (� grad v)

⌘
wid⌦ = 0, 8wi(x)
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Spatial	discretization	— electrokinetics (II)

Weak formulation

integration by parts 
Green formula

divergence theorem

only the first derivative of the electric potential is now required

8wi(x)

v · gradu+ u divv = div (uv)

Z

⌦
diva d⌦ =

I

@⌦
a d�

Z

⌦

⇣
� div (� grad v)

⌘
wi d⌦ = 0

Z

⌦

⇣
� div (wi� grad v) + � grad v · gradwi

⌘
d⌦ = 0

Z

@⌦
wi(�� grad v) d�+

Z

⌦
� grad v · gradwi d⌦ = 0
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Spatial	discretization	— electrokinetics (III)

Boundary integral

essential BC natural BC

8wi(x)

= 0 8wi(x)
if wi = 0 on �Dirichlet

Z

@⌦
wi(�� grad v) d�

n · j = jn = 0

n⇥ e = et = 0

�1

�2

n⇥ e|�e = 0

n · j|�j = 0

n · j = jn = 0

Z

�Dirichlet

wi(�� grad v) d�+

Z

�Neumann

wi(�� grad v) d�
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Spatial	discretization	— electrokinetics (IV)

Ritz-Galerkin method
Petrov-Galerkin method

v =
X

j

ujsj with sj(x) = 0 at �Dirichlet

⇢
sj(x) shape functions

uj unknowns, degrees of freedom

sj(x) = wj(x)

sj(x) 6= wj(x)

= kij

Z

⌦
� grad v · gradwi d⌦ = 0

X

j

uj

Z

⌦
� gradwj · gradwi d⌦ = 0 [kij ][uj ] = [0]

Source via constraints 
in U vector (potential at electrodes)
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Function	space	– electric	scalar	potential

Whitney Forms
 k

n

ly

m
x

k

n

ly

m
x

z

k

n
l

x

m

0 1 2 k

n

l
y

m
x

z

3
w

wn w{m, n} w{l, m, n} w{k, l, m, n}

h
n

h  dh  – h  dhn m m n

h  dh � dh  + ... + ...]l m n2[

6 dh � dh � dhk l m

0-form
nodal BF

The"MVP"is"wri^en"in"terms"of"vector"basis"func0ons"wj"(bold"w)."In"the"2D"case,"scalar"and"nodal"basis"func0ons"wj(x,y)"can"be"used"for"az"
(with"nonMbold"w)."j"is"the"index"of"the"node."
"
The"figure"on"the"lec"shows"the"wellMknown"pieceMwise"linear"basis"wj(x,y)."It"is"equal"to"1"in"the"node,"goes"down"to"0"in"a"linear"way"inside"
the"(5)"triangles"that"share"node"j,"and"is"equal"to"0"outside"these"triangles."
"
The"figure"on"the"right"has"been"obtained"with"Gmsh"and"an"az.pos"file,"as"follows."A"magnetosta0c"computa0on"is"done"with"0"current,"
using"e.g."the"EI"problem,"for"having"the"0"solu0on"in"az.pos."In"the"file"we"modify"the"lines"which"concern"a"par0cular"node,"e.g.""(0.01,"
0.03,0)."If"this"node"appears"as"second"one"in"a"triangle,"we"replace"the"second"zero"by"a"1":"
"
ST(0.006891062237143484,M0.02774325979421361,0,0.01,%0.03,0,0.01,M0.02563327372974202,0){0,1,0};"
"
ST(){}"stands"for"Scalar"quan0ty"in"a"Triangle."The"line"comprise"the"coordinates"of"the"three"nodes"of"the"triangle"and"the"scalar"value"in"each"
node."
"
There"are"a"priori"as"many"unknowns"(DOFs)"as"nodes"in"the"FE"mesh,"using"each"nodal"BF"also"as"test"func0on"(wj"versus"wi)."The"BCs"or"
constraints"lead"to"the"suppression"of"some"DOFs,"as"can"be"seen"in"the"preMfile."This"aspect"is"not"further"deepened"in"this"course."
"
The"system"of"AEs"can"be"wri^en"in"matrix"form."(All"matrices,"including"column"matrices,"are"denoted"by"bold"nonMitalic"uppercase"le^ers.)"""
"
The"S"matrix,"which"can"be"called"the"s0ffness"matrix,"is"square"and"symmetric."It"is"constant"if"all"materials"are"linear."
A"is"the"column"matrix"(or"vector)"that"contains"all"DOFs,"i.e."nodal"values"of"az"in"this"case."
J"is"the"column"matrix"that"depends"on"the"imposed"current"density."
"
Thanks"to"the"local"defini0on"of"the"BFs,"S"is"sparse."The"{i,j}Mth"element"in"S"is"nonzero"if"nodes"i"and"j"are"neigbouring"nodes."In"a"mesh"with"
nearly"equilateral"triangles,"a"node"has"most"ocen"6"neighbours,"leading"to"7"nonzero"elements"(including"the"diagonal"one)"per"row"in"S.""
"
""
"

17"

v =
X

n2N
vnsn

FunctionSpace{
{ Name Hgrad_v_EleKin; Type Form0; //discrete function space for H1_h

BasisFunction {
{ Name sn; NameOfCoef vn; Function BF_Node; //‘‘P1 FEs’’

Support DomainC_Ele; Entity NodesOf[All]; }
}
Constraint {

{ NameOfCoef vn; EntityType NodesOf; NameOfConstraint ElectricScalarPotential; }
}

}
}
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Constraint {
{ Name ElectricScalarPotential ;

Case {
{ Region Dirichlet0 ; Value 0. ; }
{ Region Dirichlet1 ; Value V_imposed ; }

}
}

}

Electrokinetic formulation:	build	equation!

Z

@⌦
wi(�� grad v) d�+

Z

⌦
� grad v · gradwi d⌦ = 0

basis function weighing function

Dirichlet constraint

Formulation {
{ Name Electrokinetics_v ; Type FemEquation ;

Quantity {
{ Name v ; Type Local ; NameOfSpace Hgrad_v_EleKin ; }

}
Equation {

Galerkin { [ sigma[] * Dof{d v} , {d v} ] ;
In DomainC_Ele ; Jacobian Vol ; Integration GradGrad ; }

}
}

}
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The"MVP"is"wri^en"in"terms"of"vector"basis"func0ons"wj"(bold"w)."In"the"2D"case,"scalar"and"nodal"basis"func0ons"wj(x,y)"can"be"used"for"az"
(with"nonMbold"w)."j"is"the"index"of"the"node."
"
The"figure"on"the"lec"shows"the"wellMknown"pieceMwise"linear"basis"wj(x,y)."It"is"equal"to"1"in"the"node,"goes"down"to"0"in"a"linear"way"inside"
the"(5)"triangles"that"share"node"j,"and"is"equal"to"0"outside"these"triangles."
"
The"figure"on"the"right"has"been"obtained"with"Gmsh"and"an"az.pos"file,"as"follows."A"magnetosta0c"computa0on"is"done"with"0"current,"
using"e.g."the"EI"problem,"for"having"the"0"solu0on"in"az.pos."In"the"file"we"modify"the"lines"which"concern"a"par0cular"node,"e.g.""(0.01,"
0.03,0)."If"this"node"appears"as"second"one"in"a"triangle,"we"replace"the"second"zero"by"a"1":"
"
ST(0.006891062237143484,M0.02774325979421361,0,0.01,%0.03,0,0.01,M0.02563327372974202,0){0,1,0};"
"
ST(){}"stands"for"Scalar"quan0ty"in"a"Triangle."The"line"comprise"the"coordinates"of"the"three"nodes"of"the"triangle"and"the"scalar"value"in"each"
node."
"
There"are"a"priori"as"many"unknowns"(DOFs)"as"nodes"in"the"FE"mesh,"using"each"nodal"BF"also"as"test"func0on"(wj"versus"wi)."The"BCs"or"
constraints"lead"to"the"suppression"of"some"DOFs,"as"can"be"seen"in"the"preMfile."This"aspect"is"not"further"deepened"in"this"course."
"
The"system"of"AEs"can"be"wri^en"in"matrix"form."(All"matrices,"including"column"matrices,"are"denoted"by"bold"nonMitalic"uppercase"le^ers.)"""
"
The"S"matrix,"which"can"be"called"the"s0ffness"matrix,"is"square"and"symmetric."It"is"constant"if"all"materials"are"linear."
A"is"the"column"matrix"(or"vector)"that"contains"all"DOFs,"i.e."nodal"values"of"az"in"this"case."
J"is"the"column"matrix"that"depends"on"the"imposed"current"density."
"
Thanks"to"the"local"defini0on"of"the"BFs,"S"is"sparse."The"{i,j}Mth"element"in"S"is"nonzero"if"nodes"i"and"j"are"neigbouring"nodes."In"a"mesh"with"
nearly"equilateral"triangles,"a"node"has"most"ocen"6"neighbours,"leading"to"7"nonzero"elements"(including"the"diagonal"one)"per"row"in"S.""
"
""
"

17"

Function	space	– temperature

FunctionSpace{
{ Name Hgrad_T; Type Form0; //discrete function space for H1_h

BasisFunction {
{ Name sn; NameOfCoef Tn; Function BF_Node; //‘‘P1 FEs’’

Support Domain_The; Entity NodesOf[All]; }
}
Constraint {

{ NameOfCoef Tn; EntityType NodesOf; NameOfConstraint Temperature; }
}

}
}

T =
X

n2N
Tnsn

Constraint {
{ Name Temperature ;

Case {
{ Region Dirichlet0 ; Value 20. ; }
{ Region Dirichlet1 ; Value 20. ; }

}
}

}
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Formulation {
{ Name Thermal_T ; Type FemEquation ;

Quantity {
{ Name T ; Type Local ; NameOfSpace Hgrad_T ; }
{ Name v ; Type Local ; NameOfSpace Hgrad_v_EleKin ; }

}
Equation {

Galerkin { [ kappa[] * Dof{d T} , {d T} ] ;
In Domain_The; Integration GradGrad ; Jacobian Vol ; }

Galerkin { DtDof[ rhoc[] * Dof{T} , {T} ] ;
In Domain_The; Integration GradGrad ; Jacobian Vol ; }

Galerkin { [ -1/sigma[] * SquNorm[sigma[]*{d v}] , {T} ] ;
In Domain_The ; Integration GradGrad ; Jacobian Vol ; }

}
}

}

Thermal	formulation:	build	equation!

⇢ cp @tT = div (gradT ) +Qv Heat conduction equation

Z

⌦T

 gradT · gradwi d⌦T +

Z

⌦T

⇢T cp @tT · wi d⌦T+ =

Z

⌦T

Qv · wi d⌦T
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Resolution {
{ Name Analysis ;

System {
{ Name Sys_EleKin ; NameOfFormulation Electrokinetics_v ; }
{ Name Sys_The ; NameOfFormulation Thermal_T ; }

}
Operation {

InitSolution[Sys_The] ;

InitSolution[Sys_EleKin] ;

Generate[Sys_EleKin]; Solve[Sys_EleKin]; SaveSolution[Sys_EleKin];

Generate[Sys_The]; Solve[Sys_The]; SaveSolution[Sys_The];

PostOperation[EleKin] ;

PostOperation[The] ;

}
}

}

Coupling:	Electrokinetic +	thermal	resolution

electrokinetic problem

electric properties
possibly f(T)

Joule loss density

thermal problem

thermal source density temperature field
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Magnetometer = Electromagnetism + Elasticity

classical Electromagnetism

Vector fields: ~B, ~H,~J, . . .
Vector analysis: div , curl , grad
Assumes Euclidean space

Euclidean

metric

classical Elasticity

Displacement field ~u
Symmetric tensors ", �
Assumes Euclidean space
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Magnetometer = Electromagnetism + Elasticity

classical Electromagnetism

Vector fields: ~B, ~H,~J, . . .
Vector analysis: div , curl , grad
Assumes Euclidean space

Euclidean

metric

classical Elasticity

Displacement field ~u
Symmetric tensors ", �
Assumes Euclidean space

⇧ Classical Elasticity and classical Electromagnetism assume a
Euclidean metric

⇧ This assumption
engineers background
hides the central role of metric
electromagnetic world and elasticity world cannot communicate
(no common concepts, the door is locked)
forbids clear electromechanical concepts (Maxwell stress tensor,
electromagnetic forces)
forbids clear sensitivity analysis (cf tomorrow)

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 3 / 44



Magnetometer = Electromagnetism + Elasticity

classical Electromagnetism

Vector fields: ~B, ~H,~J, . . .
Vector analysis: div , curl , grad
Assumes Euclidean space

Euclidean

metric

classical Elasticity

Displacement field ~u
Symmetric tensors ", �
Assumes Euclidean space

⇧ One could have done a classical introduction, boring,
⇧ We are going to open the door and see how the two worlds

communicate
⇧ Closer to research
⇧ Define the metric tensor and demonstrate its fundamental role (giant

step to understand curved spaces and general relativity)
⇧ Show that all physical quantities we need are tensors of various kinds
⇧ Finally, review the elastic part of the magnetometer model.

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 4 / 44



Elasticity

2 formulations for Elasticity
⇧ full general geometric approach (large strains, finite strain, nonlinear

elasticity)
⇧ linear elasticity, infinitesimal strain: linearization of the latter

(complicated ! simple)

www.quia.com, www.ifam.rwth-aachen.de
F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 5 / 44



Pathway to tensors

This all relies on a chain of basic mathematical concepts
⇧ continuous medium (manifold)
⇧ curve
⇧ vector
⇧ covector
⇧ tensors

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 6 / 44



Manifold ! curve
Manifold:

⇧ Analogy: sponge
⇧ continuous set of points
⇧ no defined distance between points <> rigid boby
⇧ no tearing, no creation of voids, . . .
⇧ Infinitely many curves pass through each point P of ⌦

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 7 / 44



Curve ! tangent vector

C(�) = {xi(�)},� 2 [A,B]

= {x(�), y(�), z(�)}

~V (�) = {dxi

d�
(�)}

= {dx
d�

,
dy
d�

,
dz
d�

}

= {V x ,V y ,V z}

~r(t) = {xi(t)}, t 2 [A,B]

= {x(t), y(t), z(t)}

~v(t) = {dx
dt

,
dy
dt

,
dz
dt

}

= {vx , vy , vz}

http://math.etsu.edu/multicalc/prealpha/Chap1/Chap1-7/9-7-1.gif
http://i.stack.imgur.com/VOPuE.png
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Curve ! tangent vector

⇧ Infinitely many curves pass through each point P of ⌦

⇧ Each curve has its tangent vector ~V = {V x ,V y ,V z} in P
⇧ the set of all tangent vectors at P is the tangent space TP⌦, a linear

space
⇧ if the curve is a trajectory, and the curve parameter � is the time t , the

tangent vector is the velocity
⇧ Note the upper (contravariant) indices for vector components

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 9 / 44



Vector ! covector

⇧ A covector field is a quantity that makes sense when integrated over a
curve (circulation)

⇧ Examples: force field ~f , gravity field m~g, electric field ~E , magnetic field
~H

Mechanical work

the curve C(PA,PB) = {xk (t)} is a trajectory from PA to PB

W =

Z

C(PA,PB)

~f · d ~C conventional vector representation

=

Z

C(PA,PB)
fi dCi note the lower (covariant) indices for ~f

=

Z B

A
fi

dx i

dt
dt using the parametrisation of the curve, implicit sum

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 10 / 44



Vector ! covector

Potential gravitational energy

V =

Z

C(PA,PB)
m~g · d ~C

=

Z

C(PA,PB)
mg grad z · d ~C grad z = ~ez

=

Z B

A
mg

dz
dxi

dxi

d�
d� the gradient is a covector, cov. indices

= mg(zB � zA)

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 11 / 44



Vector ! covector
Ampere law

I =
I

C

~H · d ~C ~B = µ0~H =

I

C
Hi dCi

=

I

C
Hi

dxi

d�
d� =

Z

C
(Hx

dx
d�

+ Hy
dy
d�

+ Hz
dz
d�

) d�

http://agni.phys.iit.edu/ vpa/images/mag1.jpg,
https://c1.staticflickr.com/3/2481/3789856303 7d9f858c0a.jpg

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 12 / 44



Vector and covectors ! tensors

⇧ Vectors: velocities or tangent vectors of curves
⇧ Covectors: physical quantities that make sense when integrated over a

curve or a trajectory
⇧ distinguished by covariant or contravariant indices

A vector: {V x ,V y ,V z}
A covector: {↵x ,↵y ,↵z}

⇧ covector = first example of a tensor, the simplest one, a tensor with one
vector argument and zero covector argument:

↵(~V ) = ↵iV i 2 R

⇧ contraction of repeated indices, one covariant, one contravariant

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 13 / 44



Tensors: a general definition

⇧ Generalisation of the principle of contraction for m vector arguments
and n covector arguments:

T (~V , . . . ~W
m args

,↵, . . . ,�
n args

) = T k...l
i...j V i . . .W j↵k . . .�l

⇧ Linearity for all arguments, e.g. for the first one

T (a~V + b ~W , . . . ) = aT (~V , . . . ) + bT ( ~W , . . . )

⇧ To the classroom: “Cite tensors...”
⇧ In tensor analysis, tensors are NOT always 2 dimensional arrays of

numbers!
⇧ Scalars, vectors and covectors are the simplest tensor types

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 14 / 44



Tensors: transformation matrices
⇧ Tensors with one vector argument (m = 1) and one covector argument

(n = 1) are transformation matrices

T (~V ,↵) = T k
i V i↵k

⇧ They have 9 independent components T k
i (9 terms at the right-hand

side of the above identity, due to implicit sums)
⇧ Contracting the transformation matrix with its vector argument, T (~V , .),

gives a tensor with one covector argument, i.e. a new vector
⇧ Contracting the transformation matrix with its covector argument,

T (.,↵), gives a tensor with one vector argument, i.e. a new covector
⇧ Hence the name transformation matrix. Summary so far

m n
0 0 scalar field
0 1 vector field
1 0 covector field
1 1 transformation matrix
. . .

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 15 / 44



Tensors with several arguments of the same nature

⇧ Tensors with 2 vector arguments have also 9 independent components
Tij (like transformations matrices)

T (~V , ~W ) = TijV iW j .

⇧ When there are at least two arguments of the same nature, the order of
the arguments matters in general

T (~V , ~W ) = TijV iW j 6= T ( ~W , ~V ) = TijW iV j .

⇧ The behaviour under swapping arguments of the same nature allows to
define very important tensor subclasses: symmetric and antisymmetric
tensors

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 16 / 44



Symmetric tensors

⇧ A symmetric tensor verifies

T (~V , ~W ) = T ( ~W , ~V ) 8~V , ~W

⇧ The above condition holds in particular for the basis vectors
~ex = {�i

x} = {1, 0, 0}, ~ey = {�i
y} = {0, 1, 0}, ~ez = {�i

z} = {0, 0, 1}.
⇧ Hence

T (~ex ,~ey ) = T (~ey ,~ex) ) Txy = Tyx

⇧ This yields in total 3 non trivial independent relationships

Txy = Tyx , Tyz = Tzx , Tzx = Txz

⇧ Symmetric tensors with 2 vector arguments have thus only 6=9-3
independent components.

⇧ Examples: metric tensor g, deformation tensor "

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 17 / 44



Antisymmetric tensors

⇧ Another important class of tensors are the antisymmetric tensor:

T (~V , ~W ) = �T ( ~W , ~V ) 8~V , ~W

⇧ Components with repeated indices of antisymmetric tensors always
vanish

T (~ex ,~ex) = �T (~ex ,~ex) ) Txx = �Txx ) Txx = 0

⇧ Antisymmetry yields in total 6 non trivial independent relationships

Txx = 0 , Tyy = 0 , Tzz = 0

Txy = �Tyx , Tyz = �Tzx , Tzx = �Txz

⇧ Antisymmetric tensors with 2 vector arguments have thus 3=9-6
independent components, like vectors and covectors.

⇧ Examples: current density ~J, magnetic flux density ~B

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 18 / 44



Flux density

⇧ A flux density associates a number to a facet made of 2 nonparallel
vectors

⇧ The flux is zero if the two vectors are parallel
⇧ The flux changes sign if the vectors are swapped
⇧ ) a flux density is an antisymmetric tensor with 2 vector arguments

(m = 2, n = 0)
⇧ It has 3 components like a vector or a covector...

https://inspirehep.net/record/1281391/files/multivectors good2.png
F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 19 / 44



Volume density

⇧ A volume density associates a number to a parallelepiped made of 3
nonparallel vectors

⇧ The number is zero if the any two vectors out of the three are parallel
(flat parallelepiped)

⇧ The number changes sign if any two vectors are swapped
(negative volume according to the right-hand rule)

⇧ ) a volume density is an antisymmetric tensor with 3 vector arguments
(m = 3, n = 0)

⇧ How many independent components has such a tensor?

http://www.wackerart.de/mathematik/geometric algebra/trivector.gif
F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 20 / 44



Volume density
⇧ A tensor with 3 vector arguments (m = 3, n = 0) has 27 independent

components (27 terms in the sum):

T (~U, ~V , ~W ) = Tijk UiV jW k

⇧ A volume density ⇢ is a fully antisymmetric tensor with 3 vector
arguments

⇢(~U, ~V , ~W ) = �⇢(~V , ~U, ~W ) = �⇢(~U, ~W , ~V ) . . . 8~U, ~V , ~W

and so on for any argument permutation
⇧ All 21 components with a repeated index vanish: e.g. ⇢xxy = 0
⇧ Only 6 components exist with no repeated indices, for which one has 5

relationships

⇢xyz = ⇢yzx = ⇢zxy = �⇢xzy = �⇢zyx = �⇢yxz

⇧ Antisymmetric tensors with 3 vector arguments have thus only 1
independent components, like a scalar field

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 21 / 44



Differential forms

⇧ Differential forms of order m are completely antisymmetric tensors with
m vector arguments and zero covector arguments

⇧ Originate from the theory of integration over geometrical regions
⇧ Stokes theorem: duality with the boundary operator @

Z

⌦
d↵ =

Z

@⌦
↵

Z

C(PA,PB)
gradf · d ~C = f |@C(PA,PB)

= f (PB)� f (PA)

Z

S
curl~f · d~S =

Z

@S

~f · d@~S
Z

V
div~f dV =

Z

@V

~f · d ~@V =

Z

@V

~f · ~n d@V

⇧ Accurate mathematical representation of electromagnetic fields

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 22 / 44



Differential forms: shape functions
m
0 0-form scalar function
1 1-form covector field, circulation density
2 2-form flux density
3 3-form volume density

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 23 / 44



0-forms: shape functions
m
0 0-form scalar function
1 1-form covector field, circulation density
2 2-form flux density
3 3-form volume density

The value of the shape function vi of node i of the mesh is 1 at node i , and
zero at all other nodes of the mesh.

http://www.iue.tuwien.ac.at, http://mooseframework.org
F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 24 / 44



1-forms: shape functions
m
0 0-form scalar function
1 1-form covector field, circulation density
2 2-form flux density
3 3-form volume density

The circulation of the shape function k is 1 over edge k of the mesh, and zero
over all other edges of the mesh.

http://www.iue.tuwien.ac.at/phd/nentchev/node40.html,
http://www.iue.tuwien.ac.at/phd/nentchev/node43.html
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2-forms: shape functions
m
0 0-form scalar function
1 1-form covector field, circulation density
2 2-form flux density
3 3-form volume density

The flux of the shape function k is 1 across facet k of the mesh, and zero
across all other facets of the mesh.

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 26 / 44



3-forms: shape functions

m
0 0-form scalar function
1 1-form covector field, circulation density
2 2-form flux density
3 3-form volume density

The integral of the shape function k is 1 over element k of the mesh, and zero
over all other elements of the mesh.
Draw it. . .

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 27 / 44



Tensors: overview

m n S/A
0 0 scalar field
0 1 vector field
1 0 covector field
1 1 transformation matrix
2 0 S metric tensor g, deformation tensor "
2 0 A flux density ~B, displacement current ~D
0 2 S (stress tensor �)
3 0 A volume density ⇢
. . .

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 28 / 44



Tensors: partial antisymmetrization
⇧ Partially antisymmetrized tensors are also possible

⇧ The force density ⇢
~F is a covector valued volume density

~F =

Z

V
⇢
~F dV

⇧ It is a tensor with 4 vector arguments, antisymmmetrised with respect
to the first 3 only.

⇧ The stress tensor � is a symmetric tensor with two covector arguments
in

W = � : " = �ij"ij

⇧ But the stress tensor � is a tensor with three vector arguments,
antisymmetrized over the first 2, when regarded as a surface density of
force, or a flux of momentum.

~F = �
Z

S
� · d~S = �

Z

S
� · ~n dS

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 29 / 44



Tensors: overview

⇧ Physical quantities are tensor fields with well-defined arguments and
symmetry properties

⇧ Partially antisymmetrized tensors are also possible
⇧ Many confusions in Euclidean space:

vector, covectors, flux densities, covector densities have all 3
components, and are all regarded as “vectors” in vector analysis,
despite their very different tensorial natures

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 30 / 44



Elasticity: equilibrium equation

~F = �
Z

S
� · d~S = �

Z

S
� · ~n dS (⇤)

~F =

Z

V
⇢
~F dV force density

= �
Z

@V
� · ~n d@V from (*)

= �
Z

V
div� dV Stokes theorem

Hence, for free, the equilibrium equation which is a purely gometric
statement, directly derived from the geometrical nature of � and of force
densities:

div� + ⇢
~F = 0

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 31 / 44



Finite strain elasticity: placement map

https://en.wikipedia.org/wiki/Finite strain theory By Sanpaz - Own work, CC BY 3.0,
https://commons.wikimedia.org/w/index.php?curid=4755790
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Finite strain elasticity: placement map

⇧ Material manifold: sponge
⇧ Euclidean space: ruler, notion of distance between points
⇧ placement map �: description of motion

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 33 / 44



Metric tensor

⇧ The metric tensor g is a symmetric tensor with two vector arguments
⇧ The coefficients gij(x , y , z) may depend on position (curved space)
⇧ Defines the distance on a manifold
⇧ Used in mesh generation also

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 34 / 44



Length of a curve

General case

⇧ Consider a curve C(PA,PB) from PA to PB with tangent vector ~V
⇧ The idea is to integrate a unit tangent vector along the curve to

measure its length
⇧ Normalized tangent vector, using the metric tensor g

~t =
~Vq

g(~V , ~V )

⇧ Density of curve length is the covector g(~t), using again g
⇧ Length of the curve

LC =

Z

C(PA,PB)
g(~t)

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 35 / 44



Distance between two points PA and PB
⇧ Among all curves between PA and PB, the geodesic is the one with the

minimal length
⇧ The distance between PA and PB is the length of the geodesic

d(PA,PB) = min
C

LC = min
C

Z

C(PA,PB)
g(~t)

http://math.etsu.edu/multicalc/prealpha/Chap3/Chap3-7/GeoProof.gif
F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 36 / 44



Distance between two points PA and PB

Euclidean case

In the Euclidean space, everything is more simple
⇧ gij = �ij using Cartesian coordinates
⇧ Geodesics are straigth lines
⇧ The space is flat, distance depends only on end points

d(PA,PB) =
q

(xB � xA)2 + (yB � yA)2 + (zB � zA)2

⇧ ~t = ~V
|~V |

⇧ and the metric appears explictly nowhere...
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Placement map �

⇧ Material manifold
⇧ Euclidean space
⇧ Placement map �: description of motion
⇧ the placement map is a smooth invertible mapping
⇧ It is sufficient to map all tensor quantities as well
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Finite strain, another byproduct of g
Cauchy-Green tensor: ! distance in the reference configuration

C = �g a non trivial metric tensor

= F T F F is the jacobian matrix of �

Green tensor

E =
1
2
(�g � g) general expression

=
1
2
(C � I) in Euclidean space, g = I, gij = �ij

Eij =
1
2
(
duk

dxj �ki +
duk

dxi �kj +
duk

dxi
duk

dxj ) �ki factors needed to balance indices

Infinitesimal strain: linearisation of E for small deformations

"ij =
1
2
(
duk

dxj �ki +
duk

dxi �kj)
!
=

1
2
(
dui

dxj +
duj

dxi ) =
1
2
((ru) + (ru)T )

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 39 / 44



Hooke law

⇧ Last piece of the elastic model: the constitutive relationship �(ru) or
�(")

⇧ We now proceed in Euclidean space, and stop balancing covariant and
contravariant indices (classical elasticity). Implicit summation remains
on repeated indices.

⇧ Classically, Hooke tensor with 81 components, then simplifying
assumptions

�ij = Hijkl"kl

⇧ A more intuitive approach is to decompose the 9 dimensional space of
3x3 tensors into relevant geometric subspaces

⇧ Let A be a 3x3 tensor, I be the identity tensor. One has

A
dim=9

= dev(A)
dim=5

+ I vol(A)
dim=1

+ antisym(A)
dim=3
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Hooke law

A
dim=9

= dev(A)
dim=5

+ I vol(A)
dim=1

+ antisym(A)
dim=3

with

sym(A) =
1
2
(A + AT )

antisym(A) =
1
2
(A � AT ) rotations

vol(A) =
1
3

X

k

Akk =
1
3

trace(A) compression/dilatation

dev(A) = sym(A)� I vol(A) shear

Hooke law (linear isotropic material) is then just a linear relation between the
different subspaces:

vol(�) = 3K vol(ru) 3K = bulk modulus
dev(�) = 2G dev(ru) 2G = shear modulus

antisym(�) = 0 rotations yield no stress
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Hooke law

� = dev(�) + I vol(�) + antisym(�)

= 2G dev(ru) + 3K I vol(ru) + 0
= (3K � 2G)I vol(ru) + 2G sym(ru)
= 3�I vol(ru) + 2µ sym(ru) Lamé coefficients
= �I trace(ru) + 2µ sym(ru)

3� = 3K � 2G =
3E⌫

(1 + ⌫)(1 � 2⌫)

2µ = 2G =
E

1 + ⌫

3�+ 2µ = 3K =
E

1 � 2⌫

�+ 2µ =
E(1 � ⌫)

(1 + ⌫)(1 � 2⌫)
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Inverse Hooke law

vol(ru) =
1

3K
vol(�) 3K = bulk modulus

dev(ru) =
1

2G
dev(�) 2G = shear modulus

antisym(�) = 0 rotations yield no stress

ru = dev(ru) + I vol(ru) + antisym(ru)

=
1

2G
dev(�) +

1
3K

I vol(�) + antisym(ru)

= (
1

3K
� 1

2G
)I vol(�) +

1
2G

� + antisym(ru)
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Inverse Hooke law

" = ru � antisym(ru) = (
1

3K
� 1

2G
)I vol(�) +

1
2G

�

= � ⌫

E
trace(�)I+ 1 + ⌫

E
�

⇧ ru cannot be expressed uniquely from �

⇧ antisym(ru) must be obtained another way
⇧ Lagrange multiplier in stress formulation
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Magnetometer: Exercise 1

⇧ Use course notes to write down Hooke law under the matrix form
0

BBBBBBBBBBBB@

�xx
�xy
�xz
�yx
�yy
�yz
�zx
�zy
�zz

1

CCCCCCCCCCCCA

=
�
?
�

0

BBBBBBBBBBBBB@

@u
@x
@u
@y
@u
@z
@v
@x
@v
@y
@v
@z
@w
@x
@w
@y
@w
@z

1

CCCCCCCCCCCCCA

⇧ Where is this to be found in the Magetometer model files (filename, line
number)?

⇧ Check and compare.

F. Henrotte, C. Geuzaine, R. Sabariego, E. Kuci Mechanics and elasticity with Onelab 45 / 44



Magnetometer: Exercise 2

⇧ Where is the coupling magnetic force defined in the Magetometer
model files (filename, line number)?

⇧ Write down its algebraic expression.
⇧ What is the name of this force?
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Magnetometer: Exercise 3

⇧ The magnetometer bar can be regarded as a beam with rectangular
cross section and flexural rigidity EI = Eab3/12, where a is the width
and b the thickness of the beam.

⇧ Find different ways to double the rigidity of the beam.
⇧ Make a static Onelab analysis and compare the obtained deflections

with the reference situation.
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Magnetometer: Exercise 4

⇧ Still in the static case, how can you double the deflection by modifying
the applied voltage?

⇧ How can you double the deflection by modifying electric conductivity of
the magnetometer bar?
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Optimization



Design	problem



3

• Use FEM to account for the real geometry

• Starting point: existing CAD model of a bridge

Statement of the design problem

Y

0 15.7 31.5
u

XZ

• “Optimal design” should find automatically the
structure that minimizes the bridge deflection (for a
given load F and support conditions)!



Selection	of	design	variables
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Shape	optimization

• Start with an existing CAD (from a previous design)

X

Y

Z

• Design variables are the parameters of existing CAD
• radius of a circle
• major/minor axis of ellipse
• position of nurbs control point
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• Each value of design variables provides a novel
geometry that must be re-meshed

• A FEM analysis can then be applied to obtain the
physical solution for the new geometry

Shape	optimization

Y

0 21.3 42.5
u

XZ
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Topology optimization

• Start from scratch with a block of material (steel)
• with know loading and support conditions
• without any initial guess of the initial structure

• What would be the “best” structure that
• respects the loading and support conditions?
• minimises the deflection?
• uses only a given fraction of the initial volume?
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Topology optimization

• Typically define 1 design variable/ FE as the material
(e.g. steel) density that can be either 0 (void) or 1
(solid)

• In practice there are millions of FE for finer mesh
• Impossible to check each combination since a FEM
analysis is required for each of them

• Relaxation of the problem: design variables vary
continuously from 0 to 1 -> much more efficient!



FEM-analysis	setting
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Analysis	setting	- FEM	model

• The physical behavior of the system is provided by

PDEs written in a strong form (linear elastic model)

r (⌧, z?, z̄) ⌘
Z

⌦

⇣
�(✏?) : rz̄ � g · z̄

⌘
d⌦ = 0, 8z̄ 2 Z0

z

div �(✏) + g = 0 in ⌦
�(✏) = Cijkl ✏kl eie

T
j in ⌦

z = 0 on @⌦
• The problem is equivalently written in a weak form

with a residual

• The solution z* of the system depends implicetly

and nonlinearly on design variables, i.e. on

geometry through the FE mesh.
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Analysis	setting	- FEM	model

• Application of FEM in a mesh with N nodes, leads to
the solution of linear system of algebraic equations

• z(Nx1) is the unknown field vector defined in each
node of the FE mesh

• K(NxN) is the stiffness matrix of the physical problem
• g(Nx1) is a loading term (takes into account sources)

z̄T
⇣
K(⌧)z? � g(⌧)

⌘
= 0, 8z̄ 2 Z0

z
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Analysis	setting	- FEM	model

• Application of FEM in a mesh with N nodes, leads to
the solution of (non)linear system of algebraic
equations

• z(Nx1) is the unknown field vector defined in each
node of the FE mesh

• K(NxN) is the stiffness matrix of the physical problem
• g(Nx1) is a loading term (takes into account sources)

z̄T
⇣
K(⌧)z?(⌧)� g(⌧)

⌘
= 0, 8z̄ 2 Z0

z
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Analysis	setting	- FEM	model

• FEM leads to the solution of (non)linear system of
algebraic equations (in a mesh with N nodes)

• where z(Nx1) is the unknown field vector
• K(NxN) is the stiffness matrix of the physical problem
• g(Nx1) is a loading term (takes into account sources)

• The system is usually solved using the Newton-
Raphson method

z̄T
⇣
K(⌧)z?(⌧)� g(⌧)

⌘
= 0, 8z̄ 2 Z0

z



Mathematical	formulation	of	the	
optimization	problem
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Optimization	Problem Formulation

• Find the n design variables that
• minimize the internal energy of the structure
• while using only a fraction of the initial volume

• Consideration of real CAD with the FEM constraint!
• Bound constraints on design variables.

min
⌧

1

2

Z

⌦
�(✏?) : ✏? d⌦

s.t. V (⌧)  ↵V0,

⌧min

i

 ⌧
i

 ⌧max

i

, i = 1, . . . , n

r(⌧, z?, z̄) = 0, 8z̄ 2 Z0
z

.

⌧

↵ V0
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Optimization	Problem Formulation

• For each design variable (or configuration)
• Mesh the structure (for shape optimization)
• Run FEM analysis (time consuming) : z*
• evaluate objective and constraints (postprocessing)

⌧

min
⌧

1

2

Z

⌦
�(✏?) : ✏? d⌦

s.t. V (⌧)  ↵V0,

⌧min

i

 ⌧
i

 ⌧max

i

, i = 1, . . . , n

r(⌧, z?, z̄) = 0, 8z̄ 2 Z0
z

.

• Implicit and nonlinear dependence of z* on
• each function depends implicitely and nonlinearly on
• time consuming evaluation since FEM is required

⌧

• Practically, there can be mil. of and inequalities!⌧

⌧



Optimizer	– resolution	of	the	
optimization	problem
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Optimizer

• The functions in the optimization problem depend
implicitly and nonlinearly on design variables
(possibly very large number).

• How can we find the minimum of that function
(assuming that we have only 1 design variable)?

τ

f(τ) Starting point

Local minimum

Global minimum

τ1 τ* τ**
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Gradient-free	optimizer

• Naturally converges to the global optimum!
• #function evaluations for a naïve method is
• For a small optimization problem,

• Impossible to explore the whole space with a naive
method!

• Clever algorithms that can explore the design space
are required!

n!
n!(n!�m!)

n = 10, m = 5 : 252
n = 20, m = 10 : 185000
n = 100, m = 50 : 1029
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Gradient-based optimizer

• Idea: At a given point run a FEM analysis to
evaluate the function and its derivative .

• Then compute an explicit model (sort of Taylor) of
the function (in which function evaluations do not
take time compared to FEM!).

• The model is built as convex: easy to find its
minimum (conjugate gradient, or interior point).

⌧ i

τ

f(τ)

τ1 τ* τ**τ2

Explicit convex model at τ 1 

Implicit function 
  to minimize

⌧ i
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Gradient-based optimizer

• Once the optimum of the explicit model at a given
point is found, a new explicit model is built at that
point and the procedure is repeated until
convergence to the real optimum.

• Stay always feasible during iterations and higher
convergence rate than gradient-free methods!

τ

f(τ)

τ1 τ* τ**τ2

Explicit convex model at τ1
Explicit convex model at τ2

Implicit function 
  to minimize



Application:	optimal	design	of	a	bridge



23

Optimal	design	of	a	bridge
• Shape	optimization approach

• Topology optimization approach (0-blue,	1-red)

• Fortunately the	classical bridge	is recovered!



Sensitivity	analysis
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Introduction

• “Sensitivity” is the derivative of a performance
function f (appearing in the optimization problem)
w.r.t. a design variable

d

d⌧
f(⌧, z?(⌧)) = ?

• The performance function depends on the solution
of the physical problem (at equilibrium)

• is a NxN matrix with N number of nodes in mesh
-> obtained during the resolution of the problem!
K�1

z?

z̄T
⇣
K(⌧)z?(⌧)� g(⌧)

⌘
= 0, 8z̄ 2 Z0

z
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• Pros/Cons
• Simplest method to	compute the	sensitivity
• Very slow	when the									is large	since additional
FEM	are	required!

• What is ? Solve anew the linear problem with
the perturbed geometry (with perturbed mesh)

Finite	difference	method

• First	order Taylor	approximation	of

df

d⌧
(⌧, z?) ⇡

f
�
⌧ + �⌧, z?⌧+�⌧

�
� f (⌧, z?)

�⌧

z?⌧+�⌧

#⌧

z̄T
⇣
K(⌧ + �⌧)z?⌧+�⌧ � g(⌧ + �⌧)

⌘
= 0, 8z̄ 2 Z0

z

f(⌧, z?(⌧))

#⌧
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• We end up with a linear system for

• known as equilibrium of physical system enforced
• with a loading depending only on design variable

• Requires determining

Analytic	approach	– direct	method

• Sensitivity of the performance function
?df

d⌧
(⌧, z?) =

@f

@⌧
(⌧, z?) +

@f

@z?
dz?

d⌧
dz?

d⌧

dz?

d⌧

z̄T
d

d⌧

⇣
K(⌧)z?(⌧)� g(⌧)

⌘
= 0, 8z̄ 2 Z0

z

z̄T
⇣
K(⌧)

dz?

d⌧
+ (

@K

@⌧
z? � @g

@⌧
)
⌘
= 0, 8z̄ 2 Z0

z

K�1
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• Sensitivity of	the	performance	function
?	

• is	obtained	from	the	direct	method

Analytic	approach	– adjoint method

df

d⌧
(⌧, z?) =

@f

@⌧
(⌧, z?) +

@f

@z?
dz?

d⌧
dz?

d⌧

• The	latter	is injected	into	the	sensitivity	equation

dz?

d⌧
= K�1

�@K
@⌧

z?(⌧)� @g

@⌧

⌘

df

d⌧
(⌧, z?) =

@f

@⌧
(⌧, z?)

+
@f

@z?
·K�1

�@K
@⌧

z?(⌧)� @g

@⌧

⌘
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• Where			is	the	solution	of	the	linear	adjoint	system

• known as	equilibrium	of	physical	system	enforced
• with	a	loading	depending	only	on	the	function

Analytic	approach	– adjoint method

• Derivative of	the	function
df

d⌧
(⌧, z?) =

@f

@⌧
(⌧, z?) + �T

�@g
@⌧

� @K

@⌧
z?
�

�

�̄T
�
K�� @f

@z
(z?)

�
= 0, 8�̄ 2 Z0

�

K�1
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• known as	equilibrium	of	physical	system	enforced!

• Adjoint	method

• Back-substitution	for	each performance	function

• Use	only when !

Discussion	(real	problem:														,												)

• Direct	method

• Back-substitution	for	each design	variable

• Use	only when !

df

d⌧
(⌧, z?) =

@f

@⌧
(⌧, z?) +

@f

@z?
dz?

d⌧

df

d⌧
(⌧, z?) =

@f

@⌧
(⌧, z?) + �T

�@g
@⌧

� @K

@⌧
z?
�

#⌧ << #f

#⌧ >> #f

�̄T
�
K�� @f

@z
(z?)

�
= 0, 8�̄ 2 Z0

�

K�1

z̄T
⇣
K(⌧)

dz?

d⌧
+ (

@K

@⌧
z? � @g

@⌧
)
⌘
= 0, 8z̄ 2 Z0

z



Tutorial	– Shape	optimization	of	the	
magnetometer	fundamental	frequency	
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Physical problem

• Eigenmode at a given frequency

• Design problem
• change the existing geometry
• in order to set to a desired frequency
• How can we do this?

f0

f0 fd
0
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• Second try

• Formulation of the optimization problem
• First try

Shape optimization

• Choice of design variable(s)
• Support length, or width, or position?
• Relevant variables should give high sensitivity!

min
⌧
min

⌧⌧
max

|f0(⌧)� fd
0 |

min
⌧
min

⌧⌧
max

(f0(⌧)� fd
0 )

2
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Shape	optimization

• Solve the unconstrained optimization problem for
set as support position

min
⌧
min

⌧⌧
max

(f0(⌧)� fd
0 )

2

⌧

• The problem is solved with the onelab-based
optimization code written in Python (optdriver.py).

• Hint: check graphically if the optimizer finds the
correct optimum by plotting the objective.
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Onelab-based	optimization

min f0(τ, z*)
  τ
s.t. fj(τ, z*) ≤ fj

 max

     τi	∊	[τmin,τmax] 

τ2

    Analyzer 
(Gmsh/GetDP)

τ1

τ
    Analyzer 
(Gmsh/GetDP)

Mesh - FEM

z* / f(τ, z*) / df/dτ

   Problem
Formulation 

Get f(τ, z*) - df/dτ
Optimizer 

Send f(τ, z*) - df/dτ

τ1

τ2

f2(τ, z*) = 0

f1(τ, z*)

f2(τ, z*) = 0
f3(τ, z*) = 0

τ1

τ2

τ3

τ*

r(τ, z*, z) = 0, z∈Z0
z

r(τ, z*, z) = 0, z∈Z0
z

Optimization algorithm: (handle both shape and topology optimization)
Initialize design variables (user input)
Loop (until convergence to an optimum) …

• Set the CAD (design variables) and mesh the CAD
• Analysis (FEM): evaluate performance functions
• Sensitivity analysis (FEM): evaluate the gradient of 

performance functions
• Call optimizer: update the design variables
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Onelab-based	optimization	(Gmsh/GetDP)
• Define	the	objective	as	a	function	(.pro)	and	add	the	

desired	fundamental	frequency	in	onelab	database
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Onelab-based	optimization	(Gmsh/GetDP)
• Call	the	objective	function	“objective[]”	in	the	post-

processing	associated	with	the	elastic	model.

• Call	the	post-operation
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Onelab-based	optimization	(Python)

• Create	a	onelab	client	and	specify	the	problem
• Objective	and	design	variables	as	defined	in	onelab
• Onelab	parameters	defining	the	model	(e.g.							)
• Resolution	used	in	.pro

fd
0
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Onelab-based	optimization	(Python)

• Specify	the	starting	value,	lower	(									)	and	upper	
bounds	(										)

⌧min

⌧
max

• Create	an	optimization	solver	(mma)

• Solve	the	optimization	problem



40

Run	shape	optimization	…
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Shape	optimization	results

• Initial	geometry

• Optimized	geometry

• Eigenmodes optimized geometry

initial geometry



42

Shape	optimization	results


